# Contents

*Who Should Read This Book?* .................................................. v
*What’s New in SAS Financial Management 5.3* ................................. vii
*Accessibility Features of SAS Financial Management* ............................ ix

## PART 1 SAS Financial Management on the Web 1

### Chapter 1 • Managing Forms .................................................. 3
- Forms and Form Sets .......................................................... 3
- The Forms Workspace ......................................................... 4
- Select Preferences ............................................................... 6
- Working with Forms ............................................................. 7
- Open a Form ........................................................................... 8
- Select a View ........................................................................... 9
- Select Columns for Display ...................................................... 10
- Sort the Display of Forms ....................................................... 11
- Search the Form Display ....................................................... 11
- View Form History ............................................................... 13
- Act on One or More Forms ..................................................... 13
- Add or View Form Comments .................................................. 14
- Open an Attachment ............................................................... 15
- More about Forms and Form Sets .......................................... 15

### Chapter 2 • Editing a Form in the Forms Workspace .................. 19
- Overview of Web Data Entry ................................................... 20
- Form Display .......................................................................... 20
- Entering Data ......................................................................... 23
- Copy and Paste Cells ............................................................. 26
- Spread Values across a Range of Cells ....................................... 26
- Adjust Cell Values ................................................................... 30
- Attach Comments to a Cell ....................................................... 32
- Supplemental Schedules ......................................................... 33

### Chapter 3 • Viewing Reports ................................................. 37
- Overview of the Reports Workspace ......................................... 37
- Open a Report .......................................................................... 37
- Search Reports ....................................................................... 38
- Create a Report Folder ............................................................. 39

### Chapter 4 • Viewing Content from the SAS Information Delivery Portal 41
- Log On to SAS Financial Management ...................................... 41
- Access SAS Financial Management Content from the Portal ........ 42
- The Form Status Dashboard Portlet ........................................... 42
- Display Alerts in the SAS Information Delivery Portal ................. 44
- Run SAS Financial Management Reports ................................... 44
PART 2  The SAS Financial Management Add-In for Microsoft Excel  47

Chapter 5 • Getting Started with the Excel Add-In ............................................. 49
Overview of the SAS Financial Management Add-In for Microsoft Excel .......... 49
Accessing the Excel Add-In ................................................................. 49

Chapter 6 • Viewing Financial Reports ......................................................... 51
About Financial Reports .............................................................................. 51
Viewing a Financial Report ........................................................................ 51

Chapter 7 • Working with Data Entry Forms ................................................. 53
About Data Entry ....................................................................................... 53
Bottom-Up and Top-Down Form Sets ...................................................... 54
Entering Data ............................................................................................. 55
Refreshing Values ..................................................................................... 55
Virtual Children ....................................................................................... 56
Entering Data into Parent Cells ................................................................. 56
Reviewing Data as Part of a Bottom-Up Workflow ................................... 56
Entering Data Offline ................................................................................. 57
Entering Data into a Supplemental Schedule ............................................. 58
Adjusting Values for a Range of Cells ...................................................... 59
Spreading Values across Cells ................................................................. 61

Chapter 8 • Working with Tables ................................................................. 65
Using the Table Pop-Up Menu .................................................................. 65
Changing the View Given by a Table ....................................................... 66
Pivoting a Table ....................................................................................... 66
Using Excel-Based Calculated Members .................................................. 68
Using the Frequency Dimension ............................................................... 69
Formatting Tables ..................................................................................... 69
Coordinating Slicers between Tables ....................................................... 71
Adding Comments to a Cell ...................................................................... 72
Copying a Read-Only Table to a CDA Table .............................................. 73
Generating a Forecast .............................................................................. 74
Creating a Chart from a Table ................................................................... 75
Copying a CDA Table to a Read-Only Table ............................................. 75

Index ........................................................................................................ 77
Who Should Read This Book?

Audience

This book is intended for the following audience:

• users who manage forms
• users who edit or approve forms
• users who view financial reports

If you are an administrator or a power user, also see the SAS Financial Management: Process Administrator’s Guide.
Who Should Read This Book?
What’s New in SAS Financial Management 5.3

Overview

SAS Financial Management 5.3 includes the following changes and new features.

SAS Financial Management Web Applications

The form manager, form editor, and document manager have been replaced by SAS Web applications that are displayed with the Adobe Flash Player. When they log on to SAS Financial Management, users can select workspaces for the following tasks:

• managing and editing forms
• viewing reports
• viewing security information (users must have the appropriate capabilities)

In the SAS Information Delivery Portal, administrators can create and users can display a dashboard that shows form status (for example, in progress or overdue).

Planning and Process Management

• In a financial form, an administrator can generate a forecast that is based on historical data. SAS High-Performance Forecasting is used to generate the forecast data. If forecasting is enabled for data entry, a user who is editing a form can also generate a forecast.
• The functional currency of the Organization dimension for a crossing is always used for writing data, even if the target hierarchy is from another dimension.
• As part of the audit trail for budgeting and planning processes, author and date information is stored and is available via the contributing data records for a cell crossing.
• Microsoft Excel formulas can no longer be directly entered in a data-entry table. The Calculated Values option has been removed. Similar functionality is available via the Calculated Member option and supplemental schedules.
• A new table property enables users to enter data in parent members for the Time dimension. By default, this option is disabled.
• A new table property delays sending data to the server until a refresh action takes place. The default is automatic writeback.

• Forms can now be submitted without first being edited.

• Individual forms in the same form set can have different deadlines.

• **Support for supplemental schedules:**
  • SAS Financial Management includes a data provider for supplemental schedules.
  • Supplemental schedules are now available in Web data entry.
  • In a read-only table or data-entry table, users can drill through to supplemental data.

The following features apply both to data-entry and reports:

• Comments can be attached to cell crossings in a report or a form. Depending on their scope, cell comments can be included in financial reports.

• Member properties can be used to filter the displayed members in a table.
  Member selection rules can no longer be applied to member properties. Instead, property selection rules are applied to the associated dimension members.

• Dimension members can be reordered in tables, within the boundaries of the displayed hierarchy.

• Filter member combination is now supported in Web data entry, as well as in the SAS Financial Management Add-in for Microsoft Excel.

---

**Reporting**

• The SAS Financial Management Add-in for Microsoft Excel includes enhanced support for Excel charts. One use for these charts is to display forecasted data.

• From a SAS Financial Management report, a user can create an information map that can be opened in SAS Web Report Studio as a dynamic report.

• There are several new features for publishing financial reports:
  • Financial reports can be published as dynamic Excel files or as static Excel files, PDFs, or SAS Web Report Studio reports.
  • Static reports can be published to a SAS folder or a local folder, or they can be sent as e-mail attachments. There can be separate outputs for different hierarchy members.
  • Report settings can be saved and used to generate scheduled reports.
# Accessibility Features of SAS Financial Management

## Overview

SAS Financial Management has been tested with assistive technology tools. It includes accessibility and compatibility features that improve the usability of the product for users with disabilities, with exceptions noted below. These features are related to accessibility standards for electronic information technology that were adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act of 1973 (2008 draft proposal initiative update). Applications are also tested against Web Content Accessibility Guidelines (WCAG) 2.0, part of the Web Accessibility Initiative (WAI) of the Worldwide Web Consortium (W3C). For detailed information about the accessibility of this product, send e-mail to accessibility@sas.com or call SAS Technical Support.

## Keyboard Shortcuts

The following table contains the keyboard shortcuts for the SAS Financial Management Web applications that use the Adobe Flash Player. In the user interface, the shortcuts are displayed within parentheses in tooltips and menu labels.

Some application-level keyboard shortcuts do not work when you first open an application. When that happens, press Tab to place the focus on the application and then try the keyboard shortcut again.

---

**TIP** When you use a keyboard shortcut to activate a button, first give the focus to the field or section that the button is associated with before you use the keyboard shortcut. For example, if a table has an associated button, you must first move the focus to the table before you press Ctrl+?.

<table>
<thead>
<tr>
<th>Task</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a Help pop-up window from the button.</td>
<td>Ctrl+?</td>
</tr>
<tr>
<td>Note: This shortcut does not work on some keyboards (for example, the Italian keyboard).</td>
<td></td>
</tr>
<tr>
<td>Zoom in.</td>
<td>Ctrl++</td>
</tr>
<tr>
<td>Zoom out.</td>
<td>Ctrl+-</td>
</tr>
<tr>
<td>Reset zoom state.</td>
<td>Ctrl+0</td>
</tr>
<tr>
<td>Task</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>------</td>
<td>------------------</td>
</tr>
<tr>
<td>Hide or show the application bar (includes the menu bar and the workspace bar)</td>
<td>Ctrl+Alt+Shift+M</td>
</tr>
<tr>
<td>Note: This shortcut might not work if the area that has focus contains items that begin with the letter M.</td>
<td></td>
</tr>
<tr>
<td>Open a pop-up menu</td>
<td>Shift+F9 (if a menu is available in that context)</td>
</tr>
<tr>
<td>Note: If you use Shift+F9 to display the pop-up menu, then it is always displayed in the top left corner of the user interface control that you are using.</td>
<td></td>
</tr>
<tr>
<td>Note: In some circumstances, pressing Shift+F9 will not open the pop-up menu.</td>
<td></td>
</tr>
<tr>
<td>Open the Landmarks window and move focus to the list of landmarks. Each landmark represents an area of the application window. You can quickly navigate to that area of the application by selecting a landmark.</td>
<td>Ctrl+F6 and then tab once</td>
</tr>
<tr>
<td>Temporarily invert or revert application colors (for the current session only).</td>
<td>Ctrl+~</td>
</tr>
<tr>
<td>Note: You can set the Invert application colors preference in the Preferences window if you want the color change to persist across sessions.</td>
<td></td>
</tr>
<tr>
<td>Navigate to the column headings in a table.</td>
<td>For a two-dimensional table, first ensure that the table is in focus. Press Ctrl+F8 to move the focus to the column headings and then use the arrow keys to navigate from heading to heading.</td>
</tr>
<tr>
<td>For a multidimensional table, first ensure that the table is in focus. Press Tab to move the focus to the column headings and then use the arrow keys to navigate from heading to heading.</td>
<td></td>
</tr>
<tr>
<td>Sort columns in a table.</td>
<td>To sort a single column, navigate to the column heading of the column that you want to sort. Press spacebar to sort the column.</td>
</tr>
<tr>
<td>To sort additional columns, navigate to the column heading of each additional column that you want to sort. Press Ctrl+spacebar.</td>
<td></td>
</tr>
</tbody>
</table>

**Exceptions to Accessibility Standards**

These exceptions are known to occur when using the SAS Financial Management Web applications that use the Adobe Flash Player, with Internet Explorer.
<table>
<thead>
<tr>
<th>Accessibility Issue</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using JAWS with this application can sometimes cause Internet Explorer to stop responding.</td>
<td>Using JAWS 13 or later might resolve the issue.</td>
</tr>
<tr>
<td>JAWS cannot read some of the controls in the application, such as images, icons, and buttons.</td>
<td></td>
</tr>
<tr>
<td>JAWS cannot read the tooltips of items in trees and lists.</td>
<td></td>
</tr>
<tr>
<td>JAWS refers to table controls as list boxes.</td>
<td>When JAWS reports that a control is a list box, keep in mind that it might actually be a table.</td>
</tr>
<tr>
<td>The keyboard shortcuts that are used to interact with editable tables can conflict with keyboard shortcuts for JAWS’ forms mode.</td>
<td>As a best practice, disable the JAWS virtual PC cursor when you work with tables. Tab to the table and press Insert+Z to disable the JAWS virtual PC cursor. When you finish interacting with the table, press Insert+Z to re-enable the JAWS virtual PC cursor.</td>
</tr>
<tr>
<td>JAWS cannot read two-column property tables.</td>
<td></td>
</tr>
<tr>
<td>JAWS does not correctly read the information in a table:</td>
<td></td>
</tr>
<tr>
<td>• JAWS cannot read the column headings of a table.</td>
<td></td>
</tr>
<tr>
<td>• When table cells are not editable and the focus is in the body of the table, JAWS reads an entire row at a time instead of cell by cell.</td>
<td></td>
</tr>
<tr>
<td>• When the table cells are editable, and focus is in the body of the table, JAWS reads only the first row of the table. If you use the arrow keys to select a cell or row, then JAWS does not read anything. If you press Enter to edit a cell, then JAWS reads the row that contains the edited cell.</td>
<td></td>
</tr>
<tr>
<td>When you are in a table cell, if you press Home, End, Page Up, or Page Down, the selected cell will change to be one in the first column of the currently displayed columns for the table.</td>
<td>Use the arrow keys to navigate through the cells of the table.</td>
</tr>
<tr>
<td>You cannot use the Tab key to successfully navigate the cells in a table if the table contains both editable and non-editable cells.</td>
<td>Use arrow keys to navigate to a cell. If the cell is editable, then press Enter to enter edit mode. Edit the cell. Press Esc to exit edit mode. Then, use arrow keys to navigate to the next cell.</td>
</tr>
<tr>
<td>You cannot use the keyboard to activate the links within how-to topics and Help pop-up windows.</td>
<td>Use the Help menu to access the linked documents.</td>
</tr>
<tr>
<td>Accessibility Issue</td>
<td>Workaround</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>You cannot use Shift+F10 to open a pop-up menu.</td>
<td>Use Shift+F9 to open pop-up menus that are created for the SAS application. The generic menu that is provided by the Flash player cannot be opened by Shift+F9.</td>
</tr>
<tr>
<td>You cannot use the keyboard to access the close (x) button that is in the top right corner of a tab.</td>
<td></td>
</tr>
<tr>
<td>You cannot use the keyboard to change a tab label.</td>
<td></td>
</tr>
</tbody>
</table>
Part 1

SAS Financial Management on the Web

Chapter 1
Managing Forms ................................................................. 3

Chapter 2
Editing a Form in the Forms Workspace ................................. 19

Chapter 3
Viewing Reports ................................................................. 37

Chapter 4
Viewing Content from the SAS Information Delivery Portal ........ 41
**Chapter 1**

**Managing Forms**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forms and Form Sets</td>
<td>3</td>
</tr>
<tr>
<td>The Forms Workspace</td>
<td>4</td>
</tr>
<tr>
<td>Select Preferences</td>
<td>6</td>
</tr>
<tr>
<td>Working with Forms</td>
<td>7</td>
</tr>
<tr>
<td>Receive an Alert Notification</td>
<td>7</td>
</tr>
<tr>
<td>View Available Forms</td>
<td>7</td>
</tr>
<tr>
<td>Tasks in the Forms Workspace</td>
<td>7</td>
</tr>
<tr>
<td>Capabilities for Working with Forms</td>
<td>8</td>
</tr>
<tr>
<td>Open a Form</td>
<td>8</td>
</tr>
<tr>
<td>Overview</td>
<td>8</td>
</tr>
<tr>
<td>Work with the Tile Pane</td>
<td>8</td>
</tr>
<tr>
<td>Select a View</td>
<td>9</td>
</tr>
<tr>
<td>Select Columns for Display</td>
<td>10</td>
</tr>
<tr>
<td>Sort the Display of Forms</td>
<td>11</td>
</tr>
<tr>
<td>Search the Form Display</td>
<td>11</td>
</tr>
<tr>
<td>Create a Search</td>
<td>11</td>
</tr>
<tr>
<td>Manage Searches</td>
<td>12</td>
</tr>
<tr>
<td>View Form History</td>
<td>13</td>
</tr>
<tr>
<td>Act on One or More Forms</td>
<td>13</td>
</tr>
<tr>
<td>Add or View Form Comments</td>
<td>14</td>
</tr>
<tr>
<td>Add a Comment to a Form</td>
<td>14</td>
</tr>
<tr>
<td>View Form Comments</td>
<td>15</td>
</tr>
<tr>
<td>Open an Attachment</td>
<td>15</td>
</tr>
<tr>
<td>More about Forms and Form Sets</td>
<td>15</td>
</tr>
<tr>
<td>Bottom-Up Form Sets</td>
<td>15</td>
</tr>
<tr>
<td>Top-Down Form Sets</td>
<td>16</td>
</tr>
</tbody>
</table>

---

**Forms and Form Sets**

In financial or operational planning, users enter data through forms that have been designed by a form administrator and published to the Web. Here is an example form:
A form set is a collection of forms. It has a target hierarchy (for example, a hierarchy of organizational departments or managers, or a hierarchy of accounts). This example reflects a geographical organization:

Each form is associated with a member of the target hierarchy. The target hierarchy helps determine the workflow—the order in which forms are edited and reviewed.

Every form set is either a financial form set or an operational form set:

- In general, financial form sets are for high-level planning that involves monetary values.
- Operational form sets are for detailed planning that can involve either monetary values or non-monetary values.

For example, an operational form set for salary planning would involve monetary values, but an operational form set for unit sales planning would involve non-monetary values.

For more detailed information, see “More about Forms and Form Sets” on page 15.

The Forms Workspace

In the Forms workspace of SAS Financial Management, you can manage and edit forms. The workspace is laid out as follows:
1 File menu, including Recent work and Preferences.

2 Help menu, including How-to topics and important links.

3 Workspace tabs:
   • Forms workspace: for managing and editing forms.
   • Reports workspace: for finding and opening financial reports in Microsoft Excel or in a PDF.
   • Administration workspace: for viewing security information. This workspace is available only to administrators.

   Click a tab to view that workspace.

4 Number of forms in the list, as well as the current search text and options.

5 Category pane. When you are editing a form, click Forms to return to the forms display without closing any open forms.

   Use the Expand or Collapse button to display or hide the category pane.

6 Forms workspace toolbar, including these items:
   • Refresh button.
   • Open in Excel button. Use this button to edit a financial form in Microsoft Excel.
   • Expand all button, for expanding the hierarchical display. (Hierarchy view only.)
   • Collapse all button, for collapsing the hierarchical display. (Hierarchy view only.)
   • Sort button, for sorting the display by multiple columns.
   • Manage columns button.
   • Open menu. Click Open to open the form in the default menu. Use the drop-down list to make additional selections.
Select view menu. Use this menu to specify how to display the forms, as a list (Grid view) or as a tree (Hierarchy view).

7 Headings for the list of forms. Click a column heading to sort the display by a single column. Click a column or the direction button to reverse the sort order.

8 Forms that are currently available to you. Double-click a form to open it, or use the Open menu.

9 Status bar, including results of workflow actions.

10 Details pane, containing the following sections:
   - Workflow section, for taking action on a form
   - Comments section, for viewing or adding comments to a form
   - Attachments section, for opening form attachments
   - History section, for viewing a form’s history and status

Use the Expand or Collapse button to display or hide the details pane.

11 Drag bar for controlling how much of the details pane is visible.

12 Tile pane, containing these menus:
   - Actions menu, for opening, minimizing, or closing forms in the display.
     Click a minimized form to open it for editing. Click multiple minimized forms to open them for side-by-side editing.
   - Layout menu, for managing the layout of minimized forms.

Use the Expand or Collapse button to display or hide the tile pane.

13 Search options:
   - Search box, for entering search text.
   - Additional search options button. This button opens a box in which you can filter the display.
   - Search menu, for saving or managing searches.

14 Log Off or Return to portal.

If you reached SAS Financial Management from the SAS Information Delivery Portal, the link is to return to the portal, where you can log off.

Note: When you log off or return to the portal, your workspace settings are saved, including column selections and the open or closed status of panes and sections within panes. Your current forms filter is also saved.

Select Preferences

To modify your preferences for working with SAS Financial Management, select File Preferences. In the Preferences window, you can make the following selections:

- the locale (region and language) for viewing the display.
- the theme for the display. Themes specify items such as colors and fonts.
- the workspace that appears first when you log on to SAS Financial Management.
• the number of items to display in the File ➔ Recent Work list of forms.
• whether to display icons, labels, or both.

Working with Forms

Receive an Alert Notification

When a form is available for you to work on, you receive an alert notification. The notification can be delivered in various ways, including the following:

• an e-mail message
• a text message
• a notification in the Alerts portlet of the SAS Information Delivery Portal

TIP To select the notification types that you prefer, select Options ➔ Preferences in the portal.

The alert notification contains information about a form. For example, the form is available, has been rejected, or is nearing its deadline. An e-mail notification also contains a link to the Forms workspace.

View Available Forms

To view available forms, select one of the following options:

• In a Web browser, log on to SAS Financial Management and select the Forms workspace.
• In a Web browser, log on to the SAS Information Delivery Portal. In the Alerts portlet, click an alert notification link.
• From an e-mail message, click a link to the Forms workspace.

Tasks in the Forms Workspace

The Forms workspace displays the forms that you are responsible for and that are available for editing or review. (Form administrators can view all available forms.)

If you are a form author, you edit a form and then send the form on to the next person in the workflow. If you are a form reviewer, you open the form, review its contents, and either approve or reject it, sending it on to the next person in the workflow.

Depending on your role and the form’s type and status, you can perform these tasks:

• Open a form for viewing or editing.
• Modify the form display.
• Filter the display.
• Take action on a form.
• View form history.
• Comment on a form or view existing comments.
• View a document that is attached to a form.
Capabilities for Working with Forms

To be assigned as a form author or reviewer, you must have the appropriate capabilities. If you can’t access a form, check with your administrator to make sure that you have the capabilities that you need.

Open a Form

Overview

You open a form for editing or review from the Forms workspace. Use one of the following methods:

• Double-click the form name or select Open to open the form in the default editor.

  Financial forms can be edited within the Forms workspace (Web data entry) or in Microsoft Excel. The form administrator determines which options are available. If both options are available, then Web data entry is the default.

  Operational forms can be opened only in the Forms workspace.

• Select Open ⇒ Open minimized to place a minimized version of the forms in the tile pane.

• Select Open ⇒ Add to add the selected forms to the current layout.

• (Financial forms only) Click the Open in Excel button to open the form in Microsoft Excel. This option is available only if the form administrator has enabled it for this form set. Within Excel, you can edit the form online or check out the form for offline editing.

Work with the Tile Pane

The tile pane shows the forms that you have open for Web data entry, whether the forms are displayed for editing or minimized. In this example, two forms are available:

To open a form for editing, click the form in the tile pane. To open more than one form, hold down the Shift or Control key while you select the forms.
The **Layout** menu displays a list of forms. Select **Show details** to display the form type and name. Otherwise, only the name of each form is displayed.

Select **Save Layout** to save the layout of forms that you selected. The next time you open the Forms workspace, select **Open Layout** to select a layout for display.

The **Actions** menu displays a list of actions to take on objects in the tile pane.

**TIP** To return to the forms list without closing any open forms, click the **Forms** button at the left of the screen.

---

### Select a View

With the **Select View** drop-down list, you can select either a grid view or a hierarchy view for the forms display:

<table>
<thead>
<tr>
<th>Grid</th>
<th>Hierarchy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="grid_icon.png" alt="Grid View" /></td>
<td><img src="hierarchy_icon.png" alt="Hierarchy View" /></td>
</tr>
</tbody>
</table>

**Grid** view displays a simple list of forms.

<table>
<thead>
<tr>
<th>Type</th>
<th>Member</th>
<th>Name</th>
<th>Status</th>
<th>Deadline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chicago</td>
<td>MyNewFormset</td>
<td>Edited</td>
<td>Apr 4, 2012 05:00:00 PM</td>
<td></td>
</tr>
<tr>
<td>Phoenix</td>
<td>MyViewFormset</td>
<td>Unedited</td>
<td>Apr 4, 2012 05:00:00 PM</td>
<td></td>
</tr>
<tr>
<td>Denver</td>
<td>MyViewFormset</td>
<td>Unedited</td>
<td>Apr 4, 2012 05:00:00 PM</td>
<td></td>
</tr>
<tr>
<td>Worldwide Operations</td>
<td>MyNewFormset</td>
<td>Unedited</td>
<td>Apr 4, 2012 05:00:00 PM</td>
<td></td>
</tr>
<tr>
<td>US Operations</td>
<td>MyNewFormset</td>
<td>Unedited</td>
<td>Apr 4, 2012 05:00:00 PM</td>
<td></td>
</tr>
<tr>
<td>Central Operations</td>
<td>MyNewFormset</td>
<td>Unedited</td>
<td>Apr 4, 2012 05:00:00 PM</td>
<td></td>
</tr>
</tbody>
</table>

To change the columns that are selected or the order in which they appear, click the **Manage Columns button**. (This option applies only to grid view.)

**Hierarchy** view displays forms in hierarchical order within each form set.

<table>
<thead>
<tr>
<th>Type</th>
<th>Member</th>
<th>Name</th>
<th>Status</th>
<th>Deadline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worldwide Op.</td>
<td>MyFormset</td>
<td>Unedited</td>
<td>Nov 21, 2011 05:00:00 PM</td>
<td></td>
</tr>
<tr>
<td>US Operations</td>
<td>MyFormset</td>
<td>Unedited</td>
<td>Nov 21, 2011 05:00:00 PM</td>
<td></td>
</tr>
<tr>
<td>Central Op.</td>
<td>MyFormset</td>
<td>Unedited</td>
<td>Nov 21, 2011 05:00:00 PM</td>
<td></td>
</tr>
<tr>
<td>Chicago</td>
<td>MyFormset</td>
<td>Edited</td>
<td>Nov 21, 2011 05:00:00 PM</td>
<td></td>
</tr>
<tr>
<td>Denver</td>
<td>MyFormset</td>
<td>Unedited</td>
<td>Nov 21, 2011 05:00:00 PM</td>
<td></td>
</tr>
<tr>
<td>Phoenix</td>
<td>MyFormset</td>
<td>Submitted</td>
<td>Nov 21, 2011 05:00:00 PM</td>
<td></td>
</tr>
</tbody>
</table>

To expand the entire display, click the **Expand all button**. To expand only part of the display, right-click a node and select **Expand all**.

To collapse the display, use the **Collapse all button** or right-click a node and select **Collapse all**.

In both grid view and hierarchy view, the display includes only the forms that your capabilities and form-specific assignments entitle you to edit or review.

To ensure that the display is current, click the **Refresh button**. Refreshing the page adds any forms that were published after you opened the page, removes any forms that
were withdrawn from publication, and reflects any status changes to forms. The current filter settings still apply.

Select Columns for Display

In both grid view and hierarchy view, the display can include the following columns:

**Type**

In grid view, the icons in this column indicate the type of form set the form belongs to. A small green “o” on the icon signifies an operational form set. Otherwise, the form belongs to a financial form set. The arrow indicates the direction of the workflow (bottom-up or top-down).

In hierarchy view, this column also indicates the form’s level in the hierarchy.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>📈</td>
<td>Financial planning (bottom-up workflow)</td>
</tr>
<tr>
<td>📈</td>
<td>Financial planning (top-down workflow)</td>
</tr>
<tr>
<td>📈</td>
<td>Operational planning (bottom-up workflow)</td>
</tr>
<tr>
<td>📈</td>
<td>Operational planning (top-down workflow)</td>
</tr>
</tbody>
</table>

Click the column heading to reverse the ordering of financial and operational forms.

**Member**

This column contains the name or description of the member of the target hierarchy that the form is assigned to. Typically, this is the name of an organization in an organization hierarchy.

Click the name of the target member to open the form in the default editor. If the form can be opened in both the Forms workspace or Microsoft Excel, the default is the Forms workspace.

**Name**

This column contains the name of the form set that the form belongs to.

**Status**

This column displays the form’s current status, such as Edited or Pushed.

**Deadline**

This column contains the date the form is due, displayed in your time zone.

If the deadline has passed, the due date is accompanied by a warning flag 🔄. Some forms are locked when the deadline is reached. A locked form is removed from the display. If you have a form open for editing, its status changes to read-only.

See Also

- “Bottom-Up Form Sets” on page 15
- “Top-Down Form Sets” on page 16
Sort the Display of Forms

To sort the display of forms alphabetically by a single column, click the column heading. For example, you might want to sort the available forms by the dates they are due. To reverse the alphabetical order within a column, click the arrow next to the column name.

*Note:* In hierarchy view, sorting affects only the top hierarchical level of each form set.

In grid view, you can also sort the forms by multiple columns, as follows:

1. Click the Sort button.
2. In the Sort window, select the columns on which to sort, as well as their precedence and the order of the sort (ascending or descending).

Search the Form Display

Create a Search

To search the available forms, type some text in the Search box:

![Search box with text](image)

If a value in any of the columns matches the search filter, the form is included. In hierarchy view, if a subordinate form is a match for the search filter, all parent forms are displayed as well.

To clear the search text, click the Clear search button to the right of the search text.

*Note:* This button does not clear the additional search options.

To specify additional criteria, click the Show additional search options button. You can filter the search by status, form type (financial, operational, or both), and deadline.

![Search criteria window](image)

To restore the default search options (All), click the Clear all button.
Manage Searches

To save search criteria, click the drop-down box to the left of the Search box and select **Save Search**.

The saved search filter includes the additional criteria such as form type. After saving a search filter, you can select it from the same drop-down box instead of re-creating it each time.

To reorder or delete search filters, click the drop-down box to the left of the Filter box and select **Manage Saved Searches**.

You can’t modify the search name or contents.
View Form History

Information about a form is available in the **History** section of the details pane.

![History Section of the Details Pane](image)

The following information is included:

- the status, member, and name of selected forms. Click the Delete button to deselect a form.
- form authors and reviewers. Click the E-mail button next to an author or reviewer’s name to create an e-mail message to send to that person.
- form history, including the user and date for each action.

If a form is checked out for offline editing in Microsoft Excel, the **Action** column displays that information. (To undo the check-out, select **Undo Check-out** from the **Workflow** section.)

Act on One or More Forms

The **Workflow** section of the details pane displays all actions that are currently available for the selected form. Click a button such as **Submit**. In the pop-up window that appears, you can enter a comment.

If the action completes successfully, the form is sent to the next stage in the workflow and an alert notification is sent to all users who are associated with that stage. For example, if you submit a bottom-up form, an alert notification is sent to that form’s reviewers. If you entered a comment, it is included in the alert notification text of e-mailed alerts.

If you select multiple forms, the **Workflow** section displays any actions that the selected forms have in common:
To remove a form from the **Workflow** section, click the Delete button.

After you perform an action, click **Workflow results** in the status bar at the bottom of the page. If the action failed for some reason, the workflow results log explains why.

Click the message to display more information.

**See Also**

- “The Bottom-Up Workflow” on page 15
- “The Top-Down Workflow” on page 16

---

### Add or View Form Comments

#### Add a Comment to a Form

In the **Comments** section of the Forms workspace, you can add a comment to a form, view comments, and reply to existing comments.

To add a comment:

1. Select a form.
2. In the **Comments** section, click **New Topic**.
3. Type a topic name and comment.
4. (Optional) Select a priority level (**Normal**, **High**, or **Low**) from the drop-down list. The default is **Normal** priority.
5. (Optional) Click **Attachment** to attach a document to the comment.
6. Click **Save**.

**Note:** Form comments are available to all users of that form and to all form administrators.
View Form Comments

Comments are stored by topic name. To view comments for a form:

1. Select a form.

   You can view comments for only one form at a time. By default, the Comments section displays all the comments and replies for that form, arranged by topic.

2. (Optional) From the Actions drop-down list, select a Sort and Filter option. You can sort the comments by date or by user.

3. To reply to a comment, select the comment and click Reply.

   In the Workflow section, you can also add a comment when you take action on a form. The comment topic is the action name, such as Submit or Approve.

Open an Attachment

If your form administrator has attached any files to the form set, the files are available as attachments in the Forms workspace.

Select a form. In the Attachments section of the details pane, click an attachment to open it.

More about Forms and Form Sets

This section contains background information about form sets, workflows, form actions, and form status.

Bottom-Up Form Sets

The Bottom-Up Workflow

The route that a form takes is determined by the form set's workflow. In a bottom-up form set, data is entered at the lowest hierarchical level that is defined in the form set. When the data entry for a form is complete, the author submits the form set to the reviewer for either approval or rejection. For each form level, data is entered, submitted to the next level up for approval, and aggregated if approved. If a form is rejected, it might be returned to the previous author for additional editing.

The workflow ends when one of the following actions occurs:

- The form set is locked. The form set might be locked automatically when its deadline is reached, or a form administrator might lock the form set manually.
A form administrator completes the form set (even if the flow of data has not reached the top of the hierarchy).

**Parent and Child Forms**

A parent form cannot be submitted for review until all the child forms that contribute data to it have been approved. If you are responsible for submitting a parent form and you also have sole responsibility for approving all its child forms, then you can submit the parent form as soon as all the child forms have been submitted for review.

You can enter data into a parent form if the data-entry table includes the virtual child of the parent member that the form is assigned to. Enter the data in association with the virtual child. The parent form then aggregates its virtual child data along with the data coming from the forms that are its real children. For an explanation of virtual children, see “Virtual Children” on page 25.

**Bottom-Up Form Status**

A bottom-up form can have the following status values:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Approved</td>
<td>The form has been submitted for review and has been approved by all required reviewers.</td>
</tr>
<tr>
<td>☑ Checked out</td>
<td>The form has been checked out for offline editing in Microsoft Excel.</td>
</tr>
<tr>
<td>☐ Edited</td>
<td>The form has been edited but has not yet been submitted for review.</td>
</tr>
<tr>
<td>☐ Partially Approved</td>
<td>The form has been submitted for review and has been approved by some but not all required reviewers.</td>
</tr>
<tr>
<td>☞ Rejected</td>
<td>The form has been submitted for review and has been rejected by one of its reviewers.</td>
</tr>
<tr>
<td>☐ Submitted</td>
<td>The form has been submitted for review but has not yet been approved or rejected.</td>
</tr>
<tr>
<td>☐ Unedited</td>
<td>The form has not yet been edited, or one of its subordinate forms has been removed from the workflow.</td>
</tr>
</tbody>
</table>

**Top-Down Form Sets**

**The Top-Down Workflow**

In a top-down form set, data-entry proceeds down the target hierarchy. If you are the author for the top-level form, you enter all the amounts that will cascade down the target hierarchy for the workflow. To do this, you manually enter data into crossings that include the virtual child of the top member in the target hierarchy. Then you allocate those amounts to one or more lower levels of the target hierarchy. When the data entry is complete, you use the Push action to move the form to the next level down in the form set hierarchy.

*Note:* When you edit a form using the SAS Financial Management Add-In for Microsoft Excel, an Allocation wizard is available. During Web data entry, allocations are manual.
Pushing a form does not change the amounts that were entered by the author. It only makes the subordinate forms accessible to the next set of form authors. If you are the form author at the next level in the target hierarchy, you allocate the data that you received and push it down another level.

You can enter an amount that is less than or equal to the allocated amount. Any difference is returned to the parent’s virtual child member. You can also spread allocated amounts to siblings of the allocated crossing’s dimension members. The total amount allocated must be the same or less than the original amount allocated. At the lowest level of the target hierarchy, you cannot allocate, but you can use the Spread option to redistribute those amounts.

*Note:* If you are the author of a form that has descendants, you can allocate amounts to all lower levels and then use the **Push to All** action to bypass any further allocations.

The workflow ends when one of the following actions occurs:

- The form set is locked. The form set might be locked automatically when its deadline is reached, or a form administrator might lock the form set manually.
- A form administrator completes the form set (even if the flow of data has not reached the bottom of the hierarchy).

**Top-Down Form Status**

A top-down form can have the following status values:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Completed</td>
<td></td>
</tr>
<tr>
<td>The form has received an allocation of data as a result of a <strong>Push to All</strong> action on a higher-level form. The result of the allocation can be viewed but not changed.</td>
<td></td>
</tr>
<tr>
<td>📋 Edited</td>
<td></td>
</tr>
<tr>
<td>The form has been edited but has not yet been pushed. A form also has this status if it was pushed but then recalled.</td>
<td></td>
</tr>
<tr>
<td>🗓 Holding</td>
<td></td>
</tr>
<tr>
<td>The parent form has not yet been pushed. The form cannot be edited yet.</td>
<td></td>
</tr>
<tr>
<td>Forms with Holding status are shown only to form administrators.</td>
<td></td>
</tr>
<tr>
<td>✏️ Pushed</td>
<td></td>
</tr>
<tr>
<td>The form has either been pushed down a level or pushed to all its descendants.</td>
<td></td>
</tr>
<tr>
<td>If the form was pushed down a level, then the data that was allocated to the form's children when the form was edited has been copied into the child forms.</td>
<td></td>
</tr>
<tr>
<td>If the form was pushed to all its descendants, then the data that was allocated to the form's descendants when the form was edited has been copied into the descendant forms.</td>
<td></td>
</tr>
<tr>
<td>🗑️ Unedited</td>
<td></td>
</tr>
<tr>
<td>The form has not yet been edited.</td>
<td></td>
</tr>
</tbody>
</table>
# Chapter 2

Editing a Form in the Forms Workspace

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Web Data Entry</td>
<td>20</td>
</tr>
<tr>
<td><strong>Form Display</strong></td>
<td>20</td>
</tr>
<tr>
<td>Dimensions and Crossings</td>
<td>20</td>
</tr>
<tr>
<td>Rows, Columns, and Slicers</td>
<td>20</td>
</tr>
<tr>
<td>Expand or Collapse a Row or Column</td>
<td>21</td>
</tr>
<tr>
<td>Drill Down into a Row or Column</td>
<td>22</td>
</tr>
<tr>
<td>Make Slicer Selections</td>
<td>23</td>
</tr>
<tr>
<td><strong>Entering Data</strong></td>
<td>23</td>
</tr>
<tr>
<td>Writable and Non-Writable Cells</td>
<td>23</td>
</tr>
<tr>
<td>Enter Data and Refresh the Display</td>
<td>24</td>
</tr>
<tr>
<td>Hierarchies and Parent Members</td>
<td>24</td>
</tr>
<tr>
<td>Virtual Children</td>
<td>25</td>
</tr>
<tr>
<td>Enter Data Directly into Parent Cells</td>
<td>25</td>
</tr>
<tr>
<td><strong>Copy and Paste Cells</strong></td>
<td>26</td>
</tr>
<tr>
<td><strong>Spread Values across a Range of Cells</strong></td>
<td>26</td>
</tr>
<tr>
<td>Overview of the Spread Option</td>
<td>26</td>
</tr>
<tr>
<td>Spread Values</td>
<td>27</td>
</tr>
<tr>
<td>Spread Patterns from Existing Cells</td>
<td>28</td>
</tr>
<tr>
<td>If the Target Range Includes Protected Cells</td>
<td>30</td>
</tr>
<tr>
<td><strong>Adjust Cell Values</strong></td>
<td>30</td>
</tr>
<tr>
<td>Overview</td>
<td>30</td>
</tr>
<tr>
<td>Adjust Values by Multiplier</td>
<td>30</td>
</tr>
<tr>
<td>Adjust Values by a Fixed Amount</td>
<td>31</td>
</tr>
<tr>
<td>Adjust Values by a Proportional Amount</td>
<td>31</td>
</tr>
<tr>
<td><strong>Attach Comments to a Cell</strong></td>
<td>32</td>
</tr>
<tr>
<td>Overview</td>
<td>32</td>
</tr>
<tr>
<td>Add a Comment</td>
<td>32</td>
</tr>
<tr>
<td>View Cell Comments</td>
<td>33</td>
</tr>
<tr>
<td>View the Crossing for a Comment</td>
<td>33</td>
</tr>
<tr>
<td><strong>Supplemental Schedules</strong></td>
<td>33</td>
</tr>
<tr>
<td>Overview</td>
<td>33</td>
</tr>
<tr>
<td>Enter Data in a Supplemental Schedule</td>
<td>34</td>
</tr>
<tr>
<td>Add a Detail Record</td>
<td>34</td>
</tr>
<tr>
<td>Save the Supplemental Data</td>
<td>35</td>
</tr>
</tbody>
</table>
Overview of Web Data Entry

In the Forms workspace, you can enter data into the currently selected form. A data-entry form contains one or more data-entry tables. A financial form can also contain read-only tables to provide the user with additional information.

During Web data entry, you can perform these operations:

• View data.
• Enter data into writable cells.
• Enter data in a supplemental schedule, if the form contains one.
• Copy and paste values from one range of cells to another.
• Distribute values across a range of cells, using a Spread operation.
• Modify values in a range of cells, using the Adjust Values operation.
• Enter or view comments that are associated with a cell crossing or with the form.
• Take action on the current form. For example, submit the form or approve it.

If you select one or more data cells and right-click, a pop-up menu appears. The options on the pop-up menu depend on the cells that you selected.

Form Display

Dimensions and Crossings

Dimensions are used to categorize data values (for example, by time, product, account, and customer). Each numeric value in a SAS Financial Management table belongs to a crossing that consists of one member from each dimension that is represented in the table.

The dimension members tell you what the numeric value in a data cell represents. For example, one cell’s dimension members might tell you that the numeric value represents the actual revenue for an Italian subsidiary in October 2011, expressed in euros. Another cell’s dimension members might tell you that the numeric value represents the planned salary expense for a Japanese subsidiary for fiscal year 2012, expressed in yen.

Rows, Columns, and Slicers

By default, the row, column, and slicer dimensions are displayed in the header above a data-entry table.

Use the Show menu to select the information that is displayed:
While you are editing a form, you can make changes to the display, such as the following:

- changing the position of a dimension. For example, a dimension that is currently displayed in a row can be displayed in a column or can become a slicer. To change a dimension’s position in the table:
  - Drag a dimension to a different position in the table header.
  - Alternatively, open the drop-down menu for a dimension and change its position.
- expanding or collapsing the hierarchy in a row or column.
- drilling down into the hierarchy in a row or column.
- selecting different slicer members.

These changes persist only while you are editing the form. If you close the form and reopen it, the display reverts to the original form design.

**Expand or Collapse a Row or Column**

You can expand or collapse the hierarchy display in a row or column. In this display, the columns are collapsed:

To expand the column display, click the Expand button:

The selected member and its children are displayed:
Click the Collapse button to collapse the display again.

Note: As you scroll down or pan across in a large table, the row and column headings remain stationary. Only the data cells move.

**Drill Down into a Row or Column**

In this example, the rows contain members of the My_Account dimension. The Administrative Expenses member is expanded, but the Facilities member is collapsed and you cannot see its subordinate (child) members.

Click the Drill button next to Facilities:

The display now includes only the child members of Facilities:

Notice that the table header includes the drill path (in this case, **My_Account ➔ Administrative Expense ➔ Facilities**). To drill back up in the hierarchy, click a member in the drill path.
Make Slicer Selections

In a slicer, you select one member of a hierarchy to apply to the display, in effect creating a slice of the data. Rows and columns can display multiple members of a hierarchy, but all the data cells in the table are associated with the selected slicer member.

For slicers, the table header displays both the dimension name or description and the selected member. To select a different member, click the dimension or member in the table header:

The Select Member window is displayed, and you can make a different selection:

To change the position of a slicer, click the drop-down button at the right of the slicer display:

For more information about hierarchies, see “Hierarchies and Parent Members” on page 24.

Entering Data

Writable and Non-Writable Cells

To view information about a cell in a data-entry table, right-click the cell and select Cell Information. The pop-up text contains information about the cell’s readability and writability.

Another indication of writability is the color of a cell. Cells are color-coded as follows:
<table>
<thead>
<tr>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Yellow Cell" /></td>
<td>A yellow cell is writable. You can enter data into it, and it can be the target of a <strong>Spread</strong>, <strong>Adjust Values</strong>, or <strong>Paste</strong> operation.</td>
</tr>
<tr>
<td><img src="image" alt="Red Cell" /></td>
<td>A red cell is not readable or writable. You might not be authorized to view its contents.</td>
</tr>
</tbody>
</table>
| ![White/Gray Cell](image) | A white or gray cell is not writable. It might be a parent cell, whose value comes from its subordinate members. It might also be protected, locked, or the target of a calculation. You can view the cell’s contents but you cannot enter data into it.  
*Note:* In some form sets, parent cells are writable. In that case, they are displayed in yellow. |
| ![Green Cell](image) | A green cell is not writable because its value comes from a supplemental schedule. |

**Enter Data and Refresh the Display**

To enter data into a writable cell, type a value. If the newly entered data is displayed in bold face type, then the value is not saved until a refresh operation takes place. Otherwise, the data is saved immediately. (This behavior depends on the form set design.)

To explicitly refresh the display, click the Refresh button ![Refresh](image). Other actions, such as changing a slicer value or closing the form, also trigger a refresh.

The refresh operation saves the data, formats recently entered numeric values, and recomputes values that depend on the new data. For example, the data that you enter into a cell might trigger a calculation that affects other cells.

*Note:* A refresh operation does not save data that is in a supplemental table. For that, you must select **Save supplemental data**.

**Hierarchies and Parent Members**

Hierarchies are tree structures that consist of parent-child relationships. A dimension contains one or more hierarchies, each of which can include some or all of the members of the dimension.

Here is an example of a hierarchy, or part of a hierarchy, in the Account dimension:
In data entry, you enter typically enter data in leaf members (members that have no subordinate members). Those values are added together and written to the parent member. In the example above, the values for items such as Rent, Electric, and Water would be aggregated and written to Facilities. The values for Facilities, Other, Postage, and Office Supplies would be aggregated and written to Administrative Expense, and so on.

A few members might not be saved to the parent member. That behavior is determined by the dimension administrator.

**Virtual Children**

A virtual child (VC member) is automatically assigned to any member that has child members that roll up to it. In a data-entry table, the virtual child is a writable member whose values contribute to the parent member. If the VC member is displayed in the table, you can use it to enter data for the parent without associating that data with a specific child member.

Virtual children are available in all hierarchical dimensions except the Time and Source dimensions.

**Enter Data Directly into Parent Cells**

*Note:* These options apply only to financial forms in a bottom-up workflow.

In most cases, a parent cell is read-only. Its value is derived from the values of its subordinate members. If a parent cell is designed to be writable, it is displayed in yellow. When you enter data into a writable parent cell, the value is distributed in one of these ways:

- It is written to the virtual child (VC) member for the parent.
- It is allocated to eligible subordinate cells.

These options are set by the form designer.

**See Also**

- “Copy and Paste Cells” on page 26
- “Spread Values across a Range of Cells” on page 26
- “Adjust Cell Values” on page 30
Copy and Paste Cells

You can copy a range of cells and paste their values into another range of cells. The target cells must all be writable.

To copy cells:
1. Select a range of cells.
2. Right-click and select **Copy Cells**.

To paste the values of the copied cells:
1. Select a range of cells with the same size and shape.
2. Right-click and select **Paste Cells**.

Spread Values across a Range of Cells

**Overview of the Spread Option**

Use the **Spread** option to spread values over a selected range of cells at the same level of the hierarchy. The spread can be horizontal or vertical.

In a horizontal spread, the values are spread from left to right. The source cells are in the leftmost column of the range.

![Figure 2.1 Horizontal Spread](image)

In a vertical spread, the values are spread from top to bottom. The source cells are in the topmost row of the range.

![Figure 2.2 Vertical Spread](image)
Spread Values

To spread values to a range of cells:

1. Select a range that includes both the source and target cells. The source cells must already contain the amounts that you want to spread.
   
   Note: The range cannot include a writable parent cell. (If the parent cells are not writable, they are skipped by the spread operation.)

2. Right-click and select Spread.

3. In the Spread window, select a spread direction, Horizontal or Vertical.

4. Select a spread pattern. Possible patterns are as follows:

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spread amounts evenly</td>
<td>Values are distributed evenly among the target cells.</td>
</tr>
<tr>
<td>Spread using weights</td>
<td>Each relative weight represents a percentage of the whole (100%), and target cells receive that percentage of the amount.</td>
</tr>
<tr>
<td>Spread using a 13 week account period</td>
<td>The pattern that you select is applied as weights. For example, with the 4,4,5 pattern, the first two months are considered to contain 4 weeks and receive 4/13 of the amount. The third month is considered to have 5 weeks and receives 5/13 of the amount. The pattern is repeated for any remaining months in the target rows or columns. Note: This pattern is available only when you spread over Time.</td>
</tr>
<tr>
<td>Spread using percentages</td>
<td>This pattern is similar to the relative weight pattern. Instead of weights, you assign a percentage of the amount to target rows or columns. Percentages must total 100%.</td>
</tr>
<tr>
<td>Select cells to base a spread pattern on</td>
<td>This pattern is similar to the relative weight pattern. In this case, the weights come from a range of cells that you select from a single row or column. See “Spread Patterns from Existing Cells” on page 28.</td>
</tr>
</tbody>
</table>

If you select a pattern other than Spread amounts evenly, the spread pattern section displays the first row or column in the target range and boxes for the pattern values. If you are entering weights, it also displays the corresponding percentages.
5. If the pattern that you specify is shorter than the range of target cells, the pattern is repeated (for weights) or distributed evenly (for percentages).

6. From the **Spread these amounts using** drop-down list, select the method that you want to handle existing values in the target cells.

For example, assume that you are performing a horizontal spread across three cells with values of 3, 4, and 5. You choose to spread the source amount (3) evenly across the cells. The results depend on the option that you select:

<table>
<thead>
<tr>
<th>Original values</th>
<th>Option</th>
<th>Resulting values</th>
</tr>
</thead>
<tbody>
<tr>
<td>3, 4, 5</td>
<td>Override the existing values with the spread result</td>
<td>1, 1, 1</td>
</tr>
<tr>
<td>3, 4, 5</td>
<td>Add the spread result to the existing values</td>
<td>1, 5, 6</td>
</tr>
<tr>
<td>3, 4, 5</td>
<td>Add the spread result to the sum of the existing values, then spread the result</td>
<td>4, 4, 4</td>
</tr>
</tbody>
</table>

7. Before you click **OK**, you can click **Preview** to view the effects of your selection. If you are not satisfied with the results, select a different pattern.

---

**Spread Patterns from Existing Cells**

To select a spread pattern from existing cells:
1. In the Spread window, select **Select cells to base a spread pattern on**.
   The Custom Pattern window is displayed.

2. From the table, select a range within a single row or column to act as the pattern.
   The range can be longer or shorter than the target range, and it can be either horizontal or vertical, regardless of the spread direction.

3. Click anywhere in the table in the Custom Pattern window.

4. If you click **Return to Spread**, the values in your selection are applied as weights in the spread pattern. If the pattern is shorter than the target, the weights are repeated.
   You can modify these weights in the Spread window.

5. To select a different range of cells as a pattern, click the Select Cells button.

If the Target Range Includes Protected Cells

If you spread a source value over a range that includes both protected and unprotected cells, the protected cells are not changed. The entire source value is divided among the unprotected cells. Here are some examples:

- You spread a source value of 24 evenly over four cells. The second cell is protected. The other three (unprotected) cells each receive a third of the source value, giving each cell a value of 8. The second cell is unchanged.

- You spread a source value of 20 over four cells. The second cell is protected. You use the relative weights 1, \(skip\), 2, 2. (You cannot assign a weight to a protected cell.) The second cell receives no distribution. The other three cells receive 4, 8, and 8, respectively.

Adjust Cell Values

Overview

Use the Adjust Values option to change the values in selected cells:

1. Select a range of cells.
   
   Note: The range that you select cannot contain a read-only cell, a protected cell, or a parent cell.

2. Right-click and select Adjust Values.

3. In the Adjust Values window, select the type of adjustment (multiplier, fixed value, or proportional value) and enter an adjustment amount.

   The Total selected value field displays the sum of the values in the selected cells. The Total adjusted value field gives a preview of the sum of those values after adjustment.

Adjust Values by Multiplier

To multiply the value of the value in each selected cell by a specified value:

1. In the Adjust Values window, select By multiplier.
2. Enter the multiplier in the adjacent field. It can be positive or negative. The value of each cell is multiplied by the number that you enter.

Adjust Values by a Fixed Amount

To change the value in each selected cell by a fixed amount:

1. In the Adjust Values window, select **By value**.

2. Enter the amount in the adjacent field. The amount can be positive or negative. This value is added to each selected cell.

Adjust Values by a Proportional Amount

To allocate an amount to the selected cells in proportion to their original values:

1. In the Adjust Values window, select **By value**.
2. Enter the total amount to allocate in the adjacent field.
3. Select the **Modify each cell proportionately** check box.

Here are some examples of proportional adjustment, each example affecting two cells:

<table>
<thead>
<tr>
<th>Original Values</th>
<th>Adjustment</th>
<th>Resulting Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 and 10</td>
<td>3</td>
<td>6 and 12</td>
</tr>
<tr>
<td>5 and 10</td>
<td>-3</td>
<td>4 and 8</td>
</tr>
<tr>
<td>(5) and (10)</td>
<td>3</td>
<td>(4) and (8)</td>
</tr>
<tr>
<td>(5) and (10)</td>
<td>-3</td>
<td>(6) and (12)</td>
</tr>
</tbody>
</table>

**Note:** Proportional adjustment is not possible if the selected range of cells contains both positive and negative values. In these cases, the **Modify each cell proportionately** check box is not available.
Attach Comments to a Cell

Overview

A cell comment consists of text that you attach to a single data cell in a form that you are editing or reviewing. A cell comment is associated with the cell crossing.

*Note:* For information about adding comments to an entire form, see “Add or View Form Comments” on page 14.

Add a Comment

To add a comment to a cell:

1. Select a cell.

   *Note:* The cell does not need to be writable. However, if you are denied Read access to a cell, you cannot add or view any comments for that cell.

2. In the **Cell Comments** section of the details pane, click **Add Comment** and enter the comment.

   ![Cell Comments](image)

   *Note:* If the Add Comment button is disabled, the ability to add comments might not be available for your form. In that case, you can view existing comments, but you cannot add new comments.

3. If the comment is for your personal use, select **This comment is private**.

   Otherwise, depending on the form set settings, the comment is available in other forms or reports. (Comments in operational forms are not available in reports.)

   Keep in mind that you cannot go back later and change the comment’s privacy setting. For example, to make a public comment private, you must delete the comment and re-create it.
View Cell Comments

To view cell comments:

1. Select a cell with a red flag in its upper right corner.

   Any comments that are associated with that crossing appear in the Cell Comments section. Your private comments include a locked comment icon.

2. If you also want to see comments that are associated with subordinate members, select Show Contributing Comments Indicator. In the table, select a cell with a blue flag.

   All comments that are associated with that crossing, including subordinate members, appear in the Cell Comments section. If a comment has replies, the number of replies appears in parentheses after the comment subject.

3. Use the Expand and Collapse buttons to expand or collapse the display of comments and replies.

   From the action menu, you can reply to a comment, edit the most recent comment or a reply, sort the replies, or delete comments or replies.

   Note: Unless you are an administrator, you can delete only comments and replies that you made. If a reply from someone else is attached to your comment, you can’t delete your comment.

View the Crossing for a Comment

To view the crossing for a comment:

1. Expand the Crossing folder.

2. If you click the Switch to this crossing button, the display changes to reflect the crossing that is associated with this comment.

3. Click Return to original view to go back to the previous display.

   Note: If you modified the display (for example, by rearranging columns, rows, or slicers), clicking this button might not take you to the original view.

Supplemental Schedules

Overview

A form can include one or more supplemental schedules, which provide additional information to support data entry. Each supplemental schedule is associated with a data-entry table and can contain two types of measures:

- measures that correspond to members of the data-entry table.
custom measures that were designed for use in a supplemental schedule. These measures might be numeric, or they might contain character strings, dates, or yes or no values.

You can recognize a supplemental schedule by its last two rows, which display column totals and averages in green cells. The corresponding crossings in the data-entry table are also displayed in green.

Enter Data in a Supplemental Schedule

Entering data into a supplemental schedule is like entering data into a data-entry table. You enter data in yellow (writable) cells of detail records for a specific member of the data-entry table. For example, the detail records might be associated with the organization dimension. When you open the form, only the detail records for the selected organization member are displayed.

At the bottom of the supplemental schedule are two rows that display totals and averages for the detail records. If a measure is also a member of the data-entry table, its totals are saved to the data-entry table. (The Detail averages row is provided only for reference.)

For top-down workflows, the supplemental schedule also contains a green Non-allocated row. This row displays the amount from the data-entry table that remains to be allocated in the supplemental schedule.

Add a Detail Record

In addition to entering data into existing rows, you can add new detail records. For example, if the forms are being used for a budgeting process, each new detail record might represent a planned (but not yet hired) employee.

To add a row to a supplemental schedule, right-click a row heading and select New Detail. In the New Detail window, respond to the following prompts:

Code, Name, and Description
Enter a code, name, and description for the new detail record. The name appears in the row heading for the new record.

If you type a code that already exists, a subscript is added when you click OK. For example, “MyDetail” might become “MyDetail[2]”.

Select the scope for this detail
This prompt appears only if the form set designer did not already set the scope for all detail records. Select one of the following:

• Make it available to other form sets.
  The detail record is available to any forms that have the same detail dimension.
• Limit its availability to this form set.
  The detail record is available to any forms in this form set.

Prompts for measures
Depending on form set design, you might be prompted to enter or select initial values for some of the custom measures. These fields are optional.

Some custom measures are subject to validity checks when you click OK. For example, a numeric value or a date might need to fit within a specific range. If the value that you enter does not pass a validity check, an error message is displayed and you are given the opportunity to change the value.

Note: The Reset group defaults link resets all prompts to their default values.
The following functions are also available for working with detail records:

- To modify the name and description of a detail record, right-click its row heading and select Edit Detail. (You cannot change the member code.)
- To delete a detail record, right-click its row heading and select Delete Detail.

**Save the Supplemental Data**

After you enter data into a supplemental schedule, click Save All Supplemental Data. The option affects all supplemental schedules in the form. In a bottom-up form, Save All Supplemental Data saves the totals for numeric measures to the related crossing in the source data-entry table. (Custom measures are not saved to the data-entry table.)

For a top-down form, no data is saved to the data-entry table. However, for both bottom-up and top-down forms, the supplemental schedule data is saved to the supplemental data provider’s database. In the SAS Financial Management Add-In for Microsoft Excel, this data is available when you select Contributing Data for a cell in the data-entry table.

**CAUTION:**

If the session times out, unsaved data in supplemental schedules might be lost. We recommend that you save supplemental data frequently.
Chapter 3

Viewing Reports

Overview of the Reports Workspace

Use the Reports workspace to search for and display SAS Financial Management content. The following content types are supported in the Reports workspace:

- **Microsoft Excel spreadsheet**: a dynamic SAS Financial Management report. A dynamic report is a fully functional Excel binary file. It can be modified and its data can be refreshed.
- **PDF file**: a PDF document that can be opened in Adobe Acrobat.

Other content types, such as stored processes and SAS Web Report Studio reports, are available in the SAS Information Delivery Portal. For example, you can add a stored process to a Collection portlet or to a Stored Process Navigator portlet. SAS Web Report Studio reports are also available from the File menu of SAS Web Report Studio.

Open a Report

1. In the SAS Folders column, navigate to the folder that contains the file that you want to open.
   
   You can also click the Search button to search for a file.

2. Double-click a report to open it in the appropriate viewer.
   
   Alternatively, select the filename and click the Open Report button.

The report is opened from a new browser window or tab.
Search Reports

You can search reports by title, description, date, or location.

Follow these steps:

1. Click the Search button.

2. Type some search text, or leave the search box empty to select all files that meet the other search criteria.

   The search text is not case sensitive.

3. Select Include description and keywords to search those attributes as well as the filename.

4. From the Type drop-down list, select the content type to search for:
   - (any type): any content type
   - (any applicable type): any content type that is supported in the Reports workspace
   - Microsoft Excel spreadsheet: a dynamic SAS Financial Management report
   - PDF file: a PDF document

   Select Choose types if you want to select more than one content type to search for.

5. Select the location to search.

6. (Optional) Select a range of dates in which to search.

   In this search window, the user is searching in the Shared Data folder for PDF reports, with “sales” in the title, description, or keywords, that were created in the past 7 days:

7. Click Search.
8. In the search results, use the View button to select more or less detail. You can also select a file and click the Delete button to remove it.

9. From the search results, select a file and click **OK**.
   The file location is displayed, and the filename is highlighted.
   
   *Note:* If that content type isn’t supported in the Reports workspace, clicking **OK** displays the correct location but not the file.

---

**Create a Report Folder**

To create a new folder, select the New Folder button 📁 and type a folder name. You can create new folders under **My Folder** and in some other folders, depending on the permissions that administrators have assigned.

To delete content, select a file or folder and click the Delete button ✗.
Chapter 4
Viewing Content from the SAS Information Delivery Portal

Log On to SAS Financial Management .................................................. 41
Access SAS Financial Management Content from the Portal .................. 42
The Form Status Dashboard Portlet ....................................................... 42
  Overview ......................................................................................... 42
  Working with the Portlet ................................................................. 43
  Adding the Form Status Portlet to Your Portal Page ......................... 43
Display Alerts in the SAS Information Delivery Portal ......................... 44
Run SAS Financial Management Reports ............................................ 44

Log On to SAS Financial Management

You can log on to SAS Financial Management either of the following ways:

- Respond to an alert notification that a form is ready for editing or review. See “Receive an Alert Notification” on page 7.
- Log on to the SAS Information Delivery Portal and open SAS Financial Management.

Your portal pages might already contain a link to SAS Financial Management. If you need to add a link, follow these steps:

1. In a Collection portlet, click the Edit Content button.
2. In the Edit Portlet Content window, click Add Items.
3. In the Add Items to Portlet window, click the Search tab.
4. In the Content Types list, select Application.
5. Enter Forms as a keyword and click Search.
6. In the search results, select the SAS Financial Management application and add it to your portal page.

For more information about creating a Collection portlet and adding content, see the online Help for the SAS Information Delivery Portal.
Access SAS Financial Management Content from the Portal

From the SAS Information Delivery Portal, you can access the following SAS Financial Management content:

- **a dashboard that displays form status.** See “The Form Status Dashboard Portlet” on page 42.

- **alerts of forms that are ready for editing or review.** See “Display Alerts in the SAS Information Delivery Portal” on page 44.

- **SAS reports.** SAS reports are generated by the Publish wizard in the SAS Financial Management Add-In for Microsoft Excel. These static reports can be opened in SAS Web Report Studio. They display current data but cannot be modified.

  In the portal, SAS reports can be added to a Collection portlet. Clicking a report opens it in SAS Web Report Studio.

  For more information about creating and using SAS reports and information maps, see the online Help for the SAS Financial Management Add-In for Microsoft Excel and the online Help for SAS Web Report Studio.

- **information maps.** These information maps are generated by the Information Map wizard in the SAS Financial Management Add-In for Microsoft Excel. They can be opened in SAS Web Report Studio as dynamic reports.

  In the portal, information maps can be added to a Collection portlet. Clicking an information map opens it in SAS Web Report Studio.

  *Note:* Information maps that are created in the SAS Financial Management Add-In for Microsoft Excel cannot be opened in SAS Information Map Studio.

- **standard reports.** For more information about the standard reports, see “Run SAS Financial Management Reports” on page 44.

You must have the necessary capabilities and security permissions to perform these tasks and view the data.

The Form Status Dashboard Portlet

**Overview**

In the SAS Information Delivery Portal, you can view a SAS BI Dashboard portlet with a graphical display of form status. By default, the portlet contains the following indicators:

- number of forms that are in progress, completed, or not yet started
- number of forms that are overdue or approaching deadline

The display is filtered to contain information only about forms that are available to you.
Working with the Portlet

- To modify the display, click the Edit Content button in the portlet’s toolbar.
- To view the indicators in the SAS BI Dashboard viewer instead of in a portlet, click in the BI Dashboard toolbar.
- Click an indicator to open the Forms workspace of SAS Financial Management, with that filter applied. (Might trigger an additional logon.) For example, if you click the Overdue section of the Approaching deadline indicator, the display is filtered to show only forms that are overdue.


Adding the Form Status Portlet to Your Portal Page

Your portal pages might already contain a SAS BI Dashboard portlet with the form status indicators. If not, follow these steps:

1. In the portal, select Customize ➔ Edit Page ➔ Edit Page Content.
2. On the Edit Page Content page, select Add Portlets.
3. From the drop-down list of portlets, select SAS BI Dashboard Portlet.
4. Add the portlet to the portal page.

   For more information about portlets, see the online Help for the portal.
5. Click the portlet’s Edit Content button.
6. On the Edit Portlet page, select the form status dashboard, which is located in the Products ➔ SAS Financial Management ➔ Dashboards ➔ Form status folder.
7. By default, the portlet refreshes automatically every 30 seconds. To disable this functionality, clear the Auto refresh interval check box. (You can manually refresh the portlet.) Alternatively, you can specify a larger interval.
8. Click OK.
Display Alerts in the SAS Information Delivery Portal

An alert is a notification of an event that you might need to respond to. For example, you might receive an alert that a form is available for editing or review, or you might receive an alert that your forecasting job has completed.

In the Preferences window of the portal, you can select your preferred notification methods. (You can select more than one method.) If you select My alerts portlet, alerts are displayed in an Alerts portlet that you can add to one of your portal pages. Follow these steps:

1. In the portal, select Customize ➩ Edit Page ➩ Edit Page Content.
2. On the Edit Page Content page, select Add Portlets.
3. From the drop-down list of portlets, select Shared Alerts Portlet.
4. Add the portlet to the portal page.
5. Edit the portlet if you want to display the alert type or select the alert types to be displayed.

**TIP** The Shared To-Do Alerts portlet is also available. It displays only workflow alerts.

To delete an alert, select its check box and click Remove.

For more information about portlets, see the online Help for the portal.

Run SAS Financial Management Reports

The following stored processes are available in the portal to users who have access to the /Products/SAS Financial Management/5.3 Standard Reports folder. The Audit report can be executed for any cycle, financial or operational. The other reports apply only to financial cycles.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit</td>
<td>Lists actions that have been completed. You can limit an Audit report to an object type (such as cycle or formset), a user, or a range of dates.</td>
</tr>
<tr>
<td>Data Entry</td>
<td>Lists data records that were entered through financial forms using a specified financial model. You can limit a Data Entry report to a time period, an organization, an analysis member, or a financial form set.</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Eliminations</td>
<td>Lists, for a specified financial model, data records for all accounts that have the Intercompany attribute but that are not specified in any intercompany balancing rule or net intercompany balancing rule. There should not be any such accounts, so this report should not list any data records. If the report does list data records, then you need to edit the rules that look for imbalances in intercompany accounts, or add more such rules. You can limit an Eliminations report to a time period, an organization, or an analysis member.</td>
</tr>
<tr>
<td>ETL Facts</td>
<td>Lists data records that have been loaded from SAS Data Integration Studio to a specified time period and analysis member within a specified financial cycle. You can further limit an ETL Facts report to a specified organization.</td>
</tr>
<tr>
<td>Facts</td>
<td>Lists data records that are associated with a specified financial model. You can limit a Facts report to a time period or an analysis member, and in several other ways.</td>
</tr>
<tr>
<td>ICAccounts</td>
<td>Lists, for a specified financial model, accounts that have the Intercompany attribute but that are not specified in any intercompany balancing rule or net intercompany balancing rule. You can limit an ICAccounts report to accounts that belong to a particular account type or accounts that have a particular balance type.</td>
</tr>
<tr>
<td>Intercompany</td>
<td>Lists, for a specified financial model, data records in which the account member has the Intercompany attribute and the trader member is either EXT or identical to the organization member. No records should satisfy this condition. You can limit an Intercompany report to a time period, an organization, or an analysis member.</td>
</tr>
<tr>
<td>Manual Adjustments</td>
<td>Lists all the currently posted manual adjustments for a specified financial model. You can limit a Manual Adjustments report to a time period, an organization, or an analysis member. You can also limit the report to a range of adjustment amounts.</td>
</tr>
<tr>
<td>Non Intercompany</td>
<td>Lists, for a specified financial model, data records in which the account member does not have the Intercompany attribute and the trader member is neither EXT nor identical to the organization member. No records should satisfy this condition. You can limit a Non Intercompany report to a time period, an organization, or an analysis member.</td>
</tr>
<tr>
<td>Non Leaf</td>
<td>Lists all the non-leaf data records (also known as virtual-child data records) for a specified financial model. You can limit a Non Leaf report to a time period, an organization, or an analysis member.</td>
</tr>
<tr>
<td>Ownership Adjustments</td>
<td>Lists all the adjustments that are generated by the ownership rule for a specified financial model. You can limit an Ownership Adjustments report to a time period, an analysis member, a holding organization, or a held organization.</td>
</tr>
<tr>
<td>Ownership Methods</td>
<td>Lists all the ownership relations that are specified in the ownership rule for a specified financial model, showing the consolidation method for each relation. You can limit an Ownership Methods report to a holding organization, a held organization, or a consolidation method.</td>
</tr>
<tr>
<td>Ownership Transactions</td>
<td>Lists all the asset purchases and asset sales that are specified in the ownership rule for a specified financial model. You can limit an Ownership Transactions report to a holding organization, a held organization, or a transaction type.</td>
</tr>
<tr>
<td>Rule</td>
<td>Lists all the adjustments that are generated by a specified adjustment rule within a specified financial model. You can limit a Rule report to a time period or an analysis member.</td>
</tr>
</tbody>
</table>
### Report Description

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rules Facts</td>
<td>Lists all the adjustments that are generated by all the adjustment rules that are part of a specified financial model. You can limit a Rules Facts report to a time period, an organization, or an analysis member. You can also limit the report to a range of adjustment amounts.</td>
</tr>
<tr>
<td>Trial Balance</td>
<td>Lists data records that are associated with a specified financial model and that were loaded from the SAS Financial Management staging area. You can limit a Trial Balance report to a time period, an organization, or an analysis member.</td>
</tr>
</tbody>
</table>

**Note:** In these reports, credits are shown as negative numbers and debits are shown as positive numbers.

In the portal, add one or more stored processes to a Collection portlet. Click a stored process to execute it. For more options, see the online Help for the SAS Information Delivery Portal.
Part 2

The SAS Financial Management Add-In for Microsoft Excel

Chapter 5
Getting Started with the Excel Add-In ........................................ 49

Chapter 6
Viewing Financial Reports ...................................................... 51

Chapter 7
Working with Data Entry Forms ............................................. 53

Chapter 8
Working with Tables ............................................................. 65
Chapter 5
Getting Started with the Excel Add-In

Overview of the SAS Financial Management Add-In for Microsoft Excel

The SAS Financial Management Add-In for Microsoft Excel connects your desktop copy of Microsoft Excel to the SAS Financial Management database. Through this connection, data can flow from the SAS Financial Management database to a Microsoft Excel worksheet and from a Microsoft Excel worksheet to the SAS Financial Management database.

Accessing the Excel Add-In

The following describes how to access the Excel Add-in through typical tasks:

- **Design a financial report.** Open Microsoft Excel on your desktop and then use the SAS Financial Management Log On option.

- **View a financial report.** From a Web browser, log on to SAS Financial Management and select Reports. From the navigation tree, select an Excel report. No additional logon is necessary.

- **Design a data-entry form template.** In the Forms workspace of SAS Financial Management Studio, select a form set and select Show Template. The form template opens in Microsoft Excel. No additional logon is necessary.

- **Enter data in a form.** From a Web browser, log on to SAS Financial Management and select Forms. From the list of available forms, select a form and click the Open in Excel button. The form opens in Microsoft Excel. No additional logon is necessary.
Chapter 6
Viewing Financial Reports

About Financial Reports

Overview

A financial report displays numeric values that are either stored in the SAS Financial Management database or computed from values that are stored in the SAS Financial Management database. It can contain read-only tables or cell data access (CDA) tables, or both.

Financial reports are based on financial models, not operational models.

Read-Only Tables

Read-only tables are multi-dimensional tables that provide interactive capabilities such as expanding and collapsing hierarchies, drill-down, filtering, pivoting, and commenting.

A dynamic report that is based on a read-only table displays current values from the SAS Financial Management database. A static report displays values at the time the report was published.

CDA Tables

Cell data access (CDA) tables are collections of cells that use CDA functions (such as CDAGet) to retrieve values from the SAS Financial Management database for the specified model. Reports can also contain single cells that use CDA functions to access database values.

A report that is based on a CDA table displays current values from the SAS Financial Management database. In a read-only table, users have options such as dynamic member selection and property selection rules. In contrast, the references in a CDA table are static.
Viewing a Financial Report

If you open a report from the Web, you are already logged on to SAS Financial Management and can view the report (subject to security provisions). If you open a dynamic report from a local directory, you must first log on.

If the report is dynamic and includes a read-only table, you can change your view of that table in a variety of ways, including the following:

- Select another member from a slicer dimension to display another slice of numeric values. Slicer dimensions are listed above the table itself. A worksheet with multiple tables has the option of sharing common dimensions that are placed on the slicers.
- Click an underlined row heading or column heading to expand or collapse the portion of the hierarchy that is subordinate to it.
- Select a table cell and then select an option such as Filter Member Combination, Format Members, or Pivot to affect your view of the table.
Chapter 7
Working with Data Entry Forms

About Data Entry

You enter data through forms that have been designed in SAS Financial Management Studio and published from there to the Web. The forms that you are responsible for are available to you when you log on to the SAS Financial Management Web application.

Each form typically contains one or more data-entry tables. Some forms also contain supplemental schedules, read-only tables, or CDA tables.
A form set is a collection of forms that can include data entry tables and are subject to a defined workflow process. The workflow for the form set is based on the selected target hierarchy and associated members within that hierarchy. Each form is associated with a member of the target hierarchy, although only certain members of the hierarchy might be selected to have forms.

To open a form, you log on to the Forms workspace of the SAS Financial Management Web application. Based on form set properties, you can open the form on the Web or in Microsoft Excel. From Microsoft Excel, you can also check out a form for offline editing, with some restrictions. For example, the form cannot include a supplemental schedule and cannot enable writing to parent members.

When you complete your edit or review, you use the Forms workspace to send the form to the next state in the workflow.

Note: You must have an appropriate role to enter or review data in a data-entry form.

See Also

- “Entering Data into a Supplemental Schedule” on page 58
- “Entering Data Offline” on page 57

Bottom-Up and Top-Down Form Sets

Bottom-Up Form Sets

The route that a form takes is determined by the form set's workflow. In a bottom-up form set, data is entered at the lowest hierarchical level that is defined in the form set. When the data entry for a form is complete, the author submits the form set to the reviewer for either approval or rejection. For each form level, data is entered, submitted to the next level up for approval, and aggregated if approved. If a form is rejected, it might be returned to the previous author for additional editing.

Top-Down Form Sets

In a top-down form set, data-entry proceeds down the target hierarchy. If you are the author for the top-level form, you enter all the amounts that will cascade down the target hierarchy for the workflow. To do this, you manually enter data into crossings that include the virtual child of the top member in the target hierarchy. Then you allocate those amounts to one or more lower levels of the target hierarchy. When the data entry is complete, you use the Push action to move the form to the next level down in the form set hierarchy.

Pushing a form does not change the amounts that were entered by the author. It only makes the subordinate forms accessible to the next set of form authors.

If you are the form author at the next level in the target hierarchy, you allocate the data that you received and push it down another level. Use the Allocate wizard to allocate amounts to one or more lower levels of the target hierarchy. Alternatively, you can manually enter an amount that is less than or equal to the allocated amount. Any difference is returned to the parent’s virtual child member. You can also spread allocated amounts to siblings of the allocated crossing’s dimension members. The total amount allocated must be the same or less than the original amount allocated.
At the lowest level of the target hierarchy, you cannot allocate, but you can use the **Spread** option to redistribute those amounts.

*Note:* If you are the author of a form that has descendants, you can allocate amounts to all lower levels and then use the **Push to All** action to bypass any further allocations.

### Entering Data

By default, data cells are color-coded as follows:

<table>
<thead>
<tr>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow</td>
<td>This cell is writable. You can enter data into it, and it can be the target of a spread, adjust values, or paste operation.</td>
</tr>
<tr>
<td>Red</td>
<td>This cell is not readable or writable. You might not be authorized to view its contents.</td>
</tr>
</tbody>
</table>
| Gray | This cell is not writable. It might be a parent cell, whose value comes from its subordinate members. It might also be the target of a formula, one of its members might be read-only, or it might be protected, part of a non-writable floating time period, or locked. You can view its contents but you cannot enter data into it, and it cannot be the target of a spread, adjust values, or paste operation.  

*Note:* In some form sets, parent cells are writable. In that case, they are displayed in yellow. See “Entering Data into Parent Cells” on page 56. |
| Green | The cell receives data from a supplemental schedule. (See “Entering Data into a Supplemental Schedule” on page 58.) |

For more information about a crossing, right-click the cell and select **Tools ➔ Cell Information**.

You enter data in the yellow (writable) cells. These cells belong to the organization member or members that you are responsible for. Another participant in the same workflow might see the same data-entry table with a different set of cells shown in yellow.

*Note:* You can use Excel's **Copy** and **Paste** functionality to copy values to another writable location in the form. If the Excel clipboard is open, you can paste the same selection from the clipboard multiple times.

### See Also

“Entering Data Offline” on page 57

### Refreshing Values

By default, data is stored in the database as you enter it. If the new data affects additional cells, those cells are automatically updated.
If the Delay writeback until refresh option is enabled, data is not written to the database until a refresh operation takes place. (Until then, newly entered data is displayed in bold face type.) To explicitly refresh the display, click Refresh (to refresh the current worksheet) or Refresh All (to refresh all worksheets in the workbook). Other actions, such as changing a slicer member, also trigger a refresh. The refresh operation saves the data, formats recently entered numeric values correctly, and recomputes values that depend on the new data. For example, the data that you enter into a cell might trigger a calculation that affects other cells.

When you complete your data entry, close the form. If you have pending data records, you are asked if you want to save or discard them.

Unless you are entering data offline, there is no need to save the file on your local hard drive. However, if you made changes to the form (for example, if you removed an analysis member from the data-entry table or if you made formatting changes), select Save Form Design before closing the form.

---

### Virtual Children

A virtual child (VC member) is automatically assigned to any member that has child members that roll up to it. In a data-entry table, the virtual child is a writable member whose values contribute to the parent member.

If the VC member is displayed in the table, you can use it to enter data for the parent without associating that data with a (real) child member. Virtual children are available in all hierarchical dimensions except the Time and Source dimensions.

---

### Entering Data into Parent Cells

*Note:* These options apply only to financial forms in a bottom-up workflow.

In most cases, a parent cell is gray, indicating that its value is derived from the values of its subordinate cells. If a parent cell is yellow, it is writable. When you enter data into a writable parent cell, the value is distributed in one of these ways:

- **Allow data to be entered for parent members other than time**
  
  The change in value is added to the parent’s virtual child (VC) member.

- **Allocate from Parent members other than Time using predefined weights**
  (automatic allocation)
  
  A value that is entered in a parent cell is automatically distributed among eligible leaf members, based on weights that are defined in the Allocation Weights window.

- **Allow data to be entered for Time Parent members**
  
  Users can enter a value in a non-leaf member of the Time dimension. The distribution is defined in the table properties.

For more information, see the online Help for the table properties.

*Note:* These options can be enabled or disabled only by an administrator of the form template.
Reviewing Data as Part of a Bottom-Up Workflow

Reviewing the data in a form is basically the same task as viewing a financial report.

See Also

“Viewing a Financial Report” on page 51

Entering Data Offline

Typically, you enter data into a form while the SAS Financial Management Add-In for Microsoft Excel is connected to the SAS Financial Management server.

You can also enter data into a form while it is offline. To make this possible, check out the form and save it as a local Excel file. Each time you edit the form, save it in the local file. Cells whose values depend on the data that you enter are not updated as you work. Eventually, you check the form in again, reconnecting it to the server. At that point, all the data that you entered offline is saved in the SAS Financial Management database, and all cells whose values depend on the data that you entered offline are automatically updated.

Note: You cannot check out a form that is already checked out, a form in which writing to parent members is enabled, or a form that contains a supplemental schedule.

To check out a form for offline data-entry:
1. Open the form in Microsoft Excel.
2. In Excel, select Check Out Form. The Check Out Form window appears.
3. In the Check Out Form window, click Yes. The Save As window appears.
4. In the Save As window, specify the location where you want to save the file, and then click Save.

To check in an offline form:
1. Open your local copy of the file.
2. Select Check In Form. The SAS Log On window appears.
3. In the SAS Log On window, specify the correct environment, user name, and password, and then click OK. The Check In Form window appears.
4. In the Check In Form window, click Yes.
The SAS Financial Management Add-In for Microsoft Excel connects to the SAS Financial Management server. All the data in the local copy of the form is uploaded to the SAS Financial Management database.

## Entering Data into a Supplemental Schedule

### Overview

A form can include one or more supplemental schedules, which provide additional information to support data entry. Each supplemental schedule is associated with a data-entry table and can contain two types of measures:

- measures that correspond to members of the data-entry table.
- custom measures that were designed for use in a supplemental schedule. These measures might be numeric, or they might contain character strings, dates, or true or false values.

You can recognize a supplemental schedule by its last rows, which display column totals and averages in green cells. The corresponding crossings in the data-entry table are also displayed in green.

### Enter Data in a Supplemental Schedule

#### Bottom-Up Forms

In a bottom-up form, entering data into a supplemental schedule is like entering data into a data-entry table. You enter data in yellow (writable) cells of detail records for a specific member of the data-entry table. For example, the detail records might be associated with the organization dimension. When you open the form, only the detail records for your organization member (or members) are displayed.

At the bottom of the supplemental schedule are two rows that display totals and averages for the detail records. If a measure is also a member of the data-entry table, its totals are saved in the data-entry table. (The **Detail averages** row is provided only for reference.)

#### Top-Down Forms

In a top-down form, the supplemental schedule contains a green **Non-allocated** row. This row displays the amount from the data-entry table that remains to be allocated in the supplemental schedule. You can distribute that amount among the detail records in the supplemental schedule.

No data entered in a supplemental schedule is saved to the data-entry table in a top-down form. The supplemental schedule for a top-down form enables you to create supplementary records that contain more detail than would be available in the data-entry form.

### See Also

- “Entering Data” on page 55
- “Using Excel-Based Calculated Members” on page 68


**Add a Detail Record**

In addition to entering data into existing rows, you can add new detail records. For example, if the forms are being used for a budgeting process, each new detail record might represent a planned (but not yet hired) employee.

To add a row to a supplemental schedule, right-click a row heading and select **New Detail**. In the New Detail window, respond to the following prompts:

- **Code, Name, and Description**
  
  Enter a code, name, and description for the new detail record. The name appears in the row heading for the new record.

  If you type a code that already exists, a subscript is added when you click **OK**. For example, “MyDetail” might become “MyDetail[2]”.

- **Select the scope for this detail**
  
  This prompt appears only if the form set designer did not already set the scope for all detail records. Select one of the following:

  - **Make it available to other form sets.**
    
    The detail record is available to any forms that have the same detail dimension.

  - **Limit its availability to this form set.**
    
    The detail record is available to any forms in this form set.

- **Prompts for measures**
  
  Depending on form set design, you might be prompted to enter or select initial values for some of the custom measures. These fields are optional.

  Some custom measures are subject to validity checks. For example, a numeric value or a date might need to fit within a specific range. If the value that you enter does not pass a validity check, an error symbol \(\times\) is displayed above the prompt. An error message is displayed in a tooltip for the error symbol.

*Note:* The **Reset group defaults** link resets all prompts to their default values.

The following functions are also available for working with detail records:

- To modify the name and description of a detail record, right-click its row heading and select **Edit Detail**. (You cannot edit the member code.)

- To delete a detail record, right-click its row heading and select **Delete Detail**.

**Save the Supplemental Data**

After you enter data into a supplemental schedule, click **Save All Supplemental Data**. The option affects all supplemental schedules in the form.

In a bottom-up form, **Save All Supplemental Data** saves the totals for numeric measures to the related crossing in the source data-entry table. (Custom measures are not saved to the data-entry table.)

For a top-down form, no data is saved to the data-entry table. However, for both bottom-up and top-down forms, the supplemental schedule data is saved to the supplemental data provider’s database. This data is available when you select **Contributing Data** for a cell in the data-entry table.
Adjusting Values for a Range of Cells

Overview of the Adjust Values Window

Use the Adjust Values window to change the values in selected cells:

1. Select a range of cells.
   
   *Note:* The range that you select cannot contain a read-only cell, a protected cell, or a parent cell.

2. Right-click and select Adjust Values.

3. In the Adjust Values window, select the type of adjustment (multiplier, fixed value, or proportional value) and enter an adjustment amount.

   The Total selected value field displays the sum of the values in the selected cells. The Total adjusted value field gives a preview of the sum of those values after adjustment.

Adjust Values by Multiplier

To multiply the value in each selected cell by a specified number:

1. In the Adjust Values window, select By multiplier.

2. Enter the multiplier in the adjacent field. It can be positive or negative.
   
   The value of each cell is multiplied by the value that you enter.

Adjust Values by a Fixed Amount

To change the value in each selected cell by a fixed amount:

1. In the Adjust Values window, select By value.

2. Enter the amount in the adjacent field.
   
   The amount can be positive or negative. This value is added to each selected cell.

Adjust Values by a Proportional Amount

To allocate an amount to the selected cells in proportion to their original values:

1. In the Adjust Values window, select By value.

2. Enter the total amount to allocate in the adjacent field.

3. Select the Modify each cell proportionally check box.

Here are some examples of proportional adjustment, each example affecting two cells:

<table>
<thead>
<tr>
<th>Original Values</th>
<th>Adjustment</th>
<th>Resulting Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 and 10</td>
<td>3</td>
<td>6 and 12</td>
</tr>
<tr>
<td>Original Values</td>
<td>Adjustment</td>
<td>Resulting Values</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>5 and 10</td>
<td>-3</td>
<td>4 and 8</td>
</tr>
<tr>
<td>(5) and (10)</td>
<td>3</td>
<td>(4) and (8)</td>
</tr>
<tr>
<td>(5) and (10)</td>
<td>-3</td>
<td>(6) and (12)</td>
</tr>
</tbody>
</table>

*Note:* Proportional adjustment is not possible if the selected range of cells contains both positive and negative values. In these cases, the **Modify each cell proportionally** check box is not available.

### Spreading Values across Cells

#### Overview of the Spread Window

Use the Spread window to spread values over a selected range of cells at the same level of the hierarchy. The spread can be horizontal or vertical.

In a horizontal spread, the values are spread from left to right. The source cells are in the leftmost column of the range.

In a vertical spread, the values are spread from top to bottom. The source cells are in the topmost row of the range.

#### General Tab

**Select a Spread Pattern**

Use the drop-down list for the **Pattern** field to select a spread pattern.

The following spread patterns are always available:

**Even**

The value in each source cell is spread evenly over the associated set of target cells. For example, if a source cell has four associated target cells, then each target cell receives 25% of the value in the source cell.

**Enter weights**

The value in each source cell is spread over the associated set of target cells in a way that you specify in the **Weights** section.

**predefined patterns**

Predefined patterns: 4,4,5; 4,5,4; 5,4,4.

These patterns are available only if you are spreading across time periods.

**Enter Weights**

If you select **Enter weights** in the **Pattern** field, select one of the following in the **Weights** section:
• **Relative values.** Enter a comma-separated list of numeric weights. Each relative weight represents a percentage of the whole (100%), and target cells receive that percentage of the amount.

• **Percentages.** Enter a comma-separated list of numeric percentages in the field below the radio buttons.

  This pattern is similar to the relative weight pattern. Instead of weights, you assign a percentage of the amount to target rows or columns. Percentages must total 100%.

• **Cell references.** Click the Select Cells button to select a range of cells.

  This pattern is similar to the relative weight pattern. In this case, the weights come from a range of cells that you select from a single row or column.

In each case, if the pattern that you specify is shorter than the range of target cells, the pattern is repeated.

**Spread across Time**

If you spread across time periods, then the following predefined spread patterns are also available:

• 4,4,5
• 4,5,4
• 5,4,4

These predefined patterns are meaningful only if you are spreading over months and you are using the accounting convention that each month consists of either 4 or 5 whole weeks.

As with relative weights, if the pattern that you specify is shorter than the range of target cells, the pattern is repeated.

**Change the Source or Target Selection**

To modify the source or target selection, click the Select Cells button beside the Source or Target box.

**Advanced Tab**

On the Advanced tab, you can specify the following spread options:

**Exclude virtual children**

If this check box is selected, then a target cell that includes a virtual child member in any of its dimensions does not participate in the spread operation.

*Note:* This check box is disabled if a source cell includes a virtual child member in any of its dimensions.

**Specify how to handle existing values**

If any target cell that is not a source cell contains a preexisting nonzero value, then you must specify how to handle existing values. To do this, select this check box and one of the radio buttons below it.

• **Ignore existing values:** Overwrite existing values in the target cells.
  
  This option is not available in top-down forms.

• **Keep existing values:** If a target cell has an existing value, it does not participate in the spread operation. The source amount is spread over the remaining target cells.
• **Add existing values to spread result (but not to source amount):** Instead of overwriting the target cell, the spread results are added to the existing value of the target cell.

• **Add existing values to source amount (but not to spread result):** Any existing values in the target cells are added to the source amount. Then the spread results are written to the target cells (overwriting their existing values).

For example, suppose that a source value is spread evenly over three target cells, with values of 6, 0, 9. The first target cell (with a value of 6) is the source cell. The results are as follows:

- **Ignore existing values**
  2, 2, 2

- **Keep existing values**
  3, 3, 9

  Preexisting nonzero values in target cells that are not source cells are left intact, and the entire source amount is spread over the other target cells.

- **Add existing values to spread result (but not to source amount)**
  2, 2, 11

  Preexisting nonzero values in target cells that are not source cells are used in the final step of the computation. First, a set of target values is computed from the value in the source cell. Then, for any cell that had a preexisting nonzero value, the preexisting value is added to the value that was computed from the source value.

  In the example, after the spread operation the first target cell contains 2, the second target cell contains 2, and the third target cell contains 2 + 9 = 11.

- **Add existing values to source amount (but not to spread result)**
  5, 5, 5

  Preexisting nonzero values in target cells that are not source cells are used in the first step of the computation. First, all nonzero values in target cells that are not source cells are added to the source value. Then, the resulting sum is spread over the target cells.

  In the example, after the spread operation each of the three target cells contains (6+9)/3 = 5.
Chapter 8
Working with Tables

Using the Table Pop-Up Menu .................................................. 65
Changing the View Given by a Table ............................................ 66
Pivoting a Table ........................................................................ 66
  Overview of Pivoting ............................................................. 67
  Using the Pivot Option .......................................................... 67
  Drag-and-Drop Pivoting ......................................................... 67
  Removing Dimensions with the Delete Key ......................... 68
Using Excel-Based Calculated Members ..................................... 68
  About Calculated Members .................................................. 68
  References to Members That Are Not on the Table ............... 69
Using the Frequency Dimension ............................................... 69
Formatting Tables ..................................................................... 69
  Modifying Formats for SAS Financial Management Tables .... 70
  Format Cells ........................................................................ 70
  Format Members ................................................................... 70
  Modify Cell Styles .................................................................. 70
  Resolving Conflicts between Format Specifications .............. 71
Coordinating Slicers between Tables ......................................... 71
Adding Comments to a Cell ...................................................... 72
  About Cell Comments ........................................................ 72
  Add a Comment ................................................................... 72
  View Comments ................................................................... 73
  View the Crossing for a Comment ....................................... 73
Copying a Read-Only Table to a CDA Table ............................... 73
Generating a Forecast ............................................................. 74
  Overview ............................................................................ 74
  Execution Time .................................................................... 74
  Forecast Results ................................................................... 75
Creating a Chart from a Table .................................................. 75
Copying a CDA Table to a Read-Only Table ............................... 75
Using the Table Pop-Up Menu

If you select any cell in a Microsoft Excel spreadsheet and click the right mouse button, a pop-up menu appears. If the selected cell is in a SAS Financial Management table, then the pop-up menu includes additional options that are provided by SAS Financial Management. The set of additional options depends on the type of table that you are working with and the type of cell that you select within the table.

Every option that is on the table pop-up menu is also on one of the menus above the workbook display. The table pop-up menu gives you an alternative way to access the options that manipulate existing tables. The dictionary of menu options includes an entry for every menu option. Each entry specifies all the ways in which the option can be accessed.

Changing the View Given by a Table

Here are some ways in which you can change the set of crossings whose values are displayed in a table:

- Double-click any underlined row heading or column heading. The underlined headings are non-leaf members of the hierarchy that they belong to. Double-clicking an underlined heading expands or collapses the portion of the hierarchy that is subordinate to it.
- Select a Drill, Collapse, or Expand option.
- Select a different member of a slicer dimension, if the table has slicer dimensions. This switches the display to a slice of values that is associated with the newly selected slicer member.
- Pivot the table, using either the Pivot option or drag-and-drop techniques.
- Select a dimension by selecting one of its members. Then use the Show Members option to define a different subset of the members of that dimension to include in the table.
- Use the Filter Member Combination and Filters options to suppress and restore the display of certain rows or columns.
- Use the Table Properties option to set a different default member for a dimension that is not part of the table layout, or to switch to a different model.

See Also

“Pivoting a Table” on page 66
Pivoting a Table

Overview of Pivoting

Any change in the role that any dimension plays in a table is a case of pivoting the table. Pivoting a table includes all of the following:

- adding a row dimension, column dimension, or slicer dimension
- removing a row dimension, column dimension, or slicer dimension
- moving a dimension from one part of the table to another: from row to column or slicer, from column to row or slicer, from slicer to row or column
- changing the display order of the slicer dimensions
- changing the nesting order of the row dimensions or the column dimensions

Note: In a data-entry form, you can drag a dimension from one position to another (for example, from rows to columns), but you cannot add or delete dimensions, and the arrows in the Pivot window are disabled.

Using the Pivot Option

To open the Pivot window: from the Members menu, select Pivot.

Drag-and-Drop Pivoting

You can do many types of pivoting by dragging a table cell onto a target cell, as follows:

1. Select the dimension that you want to drag by clicking a member cell of the dimension. For a slicer dimension, you can also click the cell that holds the name of the dimension.

2. Without pressing a mouse button, move the cursor to the border of the selected cell. The directional arrow symbol appears. Make sure that this symbol is visible before you continue.

3. Press the left mouse button and drag the selected cell to a target cell.

4. When the selected cell coincides with the target cell, release the mouse button. A popup message appears, asking if you want to replace the contents of the destination cells.

5. Click OK.

The role of the dragged dimension changes as specified by the following table.

<table>
<thead>
<tr>
<th>Target Cell</th>
<th>Resulting Role of the Dragged Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>slicer cell</td>
<td>slicer dimension immediately before the slicer dimension that contains the target cell</td>
</tr>
<tr>
<td>row heading cell</td>
<td>row dimension immediately to the left of the row dimension that contains the target cell</td>
</tr>
</tbody>
</table>
These drag-and-drop operations have the following limitations:

- The target table cell must occupy only a single Excel spreadsheet cell. A large row heading cell or column heading cell that results from nesting two or more row dimensions or column dimensions cannot be the target cell of a drag-and-drop pivot operation.
- If the dragged table cell occupies more than one Excel spreadsheet cell, then you must drop the first spreadsheet cell that is part of the dragged table cell onto the target table cell.
- You cannot drag a row or column dimension into a slicer dimension if the table does not already have a slicer dimension.
- You cannot drag a dimension into the last slicer position, after all existing slicers.

Removing Dimensions with the Delete Key

You can remove a dimension from a table in the following way:

1. Select a member of a row or column dimension, or the dimension label of a slicer dimension.
2. Press the Delete key.

Note: You cannot remove the last row dimension or the last column dimension of a table.

Using Excel-Based Calculated Members

About Calculated Members

You can add calculated members to a read-only table, a data-entry table, or a supplemental schedule. Each calculated member is associated with a formula that is used to calculate its values. The calculation is done after any server-side calculations.

Calculated-member formulas use the syntax of Microsoft Excel formulas. In addition to Excel functions and expressions, the formula can include the calculated-member functions that are provided by the SAS Financial Management Add-In for Microsoft Excel.

To add, delete, or edit a calculated member, click anywhere in the table and select Members ⇒ Calculated Members.
To view the formula for a calculated member, select its heading in the table or supplemental schedule. The formula is displayed in a tooltip.

For more information, see the online Help for the calculated-member wizard and the dictionary of calculated-member functions. In addition, the *SAS Financial Management: Formula Guide* contains detailed information and examples.

**References to Members That Are Not on the Table**

Occasionally the formula for a calculated member refers to a member that is not on the table. The referenced member might be excluded because of member selection rules or property selection rules, or it might be hidden by a filter. The results are as follows:

- In a read-only table or a data-entry table, the reference becomes a CDA function and continues to work correctly in Excel.
- On the Web, the result is displayed as an empty cell.

*Note:* If the calculated member’s position refers to an excluded member, the calculated member is not displayed at all.

- In a supplemental schedule, the formula is invalid. A calculated-member formula works correctly only if every member or measure that it refers to is navigable in the supplemental schedule.

---

**Using the Frequency Dimension**

The frequency dimension provides a supplementary perspective on the dimension of time. It is not a fully independent dimension. The frequency dimension is predefined and cannot be revised. It consists of a single flat set of members.

By combining a given time period with different members of the frequency dimension, you can display different but related numeric values that are associated with that time period. For example, consider a revenue account such as Total Sales and a month such as June 2010. You can combine these with various frequency members as follows:

- Combine them with Period Activity to represent total sales for June 2010. This is the default if you do not include the frequency dimension in your table.
- Combine them with Year To Date to represent total sales for the year 2010 through June 2010.
- Combine them with Quarter To Date to represent total sales for the quarter that includes June 2010, through June 2010.
- Combine them with Life To Date to represent total sales for the time span that is covered by your SAS Financial Management data, through June 2010.
Formatting Tables

Modifying Formats for SAS Financial Management Tables

You can modify the formatting in a SAS Financial Management table in these different ways:

- **Format Cells** applies ad hoc formatting to a selected cell or range of data cells in a table.
- **Format Members** assigns formatting styles to members. The style applies to all the data cells in the selected table with crossings that contain those members.
- **Cell Styles** applies formatting to table components including headings. This option can apply to a table, or you can create a template that applies to new reports. Using style merging, you can also apply style changes to existing reports or form templates.

You can affect the table display in other ways such as hiding slicers, selecting the display methods for zero and invalid values, and selecting whether to wrap labels. For details, see the online Help for table properties.

Format Cells

Use the Microsoft **Format Cells** option to apply ad hoc formatting to a selected cell or range of cells.

Apply this option only to data cells, not to row or column headings. Row and column headings revert to their original formatting when the display is refreshed.

To include these changes when you save the file, you must take the following additional steps:

1. Select a range of cells that includes the formatted cells.
2. Select **Attach Style Changes**.

Format Members

Use the Format Members window to assign cell formatting styles to members. These styles are defined in the Microsoft Excel Cell Styles window. A style that is assigned to a member is applied to all the data cells whose crossings contain that member. This style affects only the selected table.

To use this option, right-click a cell in the table and select **Members** ⇒ **Format Members**.

Modify Cell Styles

Overview

Styles for headings and cells are defined in the Cell Styles window of Microsoft Excel. You can create new styles and apply these them to the table's components, or you can modify existing styles. For example, you might want to change the font size or background color for headings, or you might want to change the color of protected cells.
On the **Styles** tab of the Table Properties window, styles can be applied to the functional components of a table such as row headings, column headings, and data cells. Notice that separate styles are assigned to row headings and drillable row headings, and to column headings and drillable column headings.

The cell styles are also available in the Format Members window.

**Save Styles in a Template**

You can save these cell styles in a template and apply them to new or existing reports and form templates. Follow these steps:

1. Open a SAS Financial Management report.
2. Open the cell styles properties (in Excel 2010, select **Home (Styles) ⇒ Cell Styles**).
3. Modify the SAS Financial Management cell styles. For example, you might modify font colors or numeric formats. You can see the effect of any changes in the report. Do not create new styles. Instead, modify the existing styles.
4. With the report still open, open a new Excel workbook.
5. In the new workbook, select **Home (Styles) ⇒ Cell Styles**.
6. At the bottom of the **Cell Styles** window, select **Merge styles**, and select the report with the modified styles.

   The SAS Financial Management styles are copied to your new (blank) workbook.
7. Save the workbook as a template.

When you create new reports, begin with the template, which will have your modified cell styles.

**Apply Styles to an Existing File**

To apply the cell styles to an existing report or to a form template:

1. Open the Excel template with the modified cell styles.
2. Open the report or form template.
3. Merge the cell styles from the Excel template with the styles in your report or form template.

   When you are asked if you want to merge styles with the same name, respond **Yes**.

**Resolving Conflicts between Format Specifications**

If there are conflicts in data cells between formatting that you set in these different ways, then the conflicts are resolved by the following precedence ordering:

1. formatting that is set with the Microsoft **Format Cells** option
2. formatting that is set with **Format Members**
3. formatting that is set with **Table Properties**

It is also possible to have conflicts within **Format Members** between members of different dimensions. These conflicts are resolved by the **Dimension Precedence** tab of the Format Members window.
Coordinating Slicers between Tables

If the same hierarchy plays the role of a slicer in two or more read-only tables or data-entry tables in the same workbook, then it is possible to connect these slicers in such a way that selecting a slicer member in one table automatically selects the same slicer member in other tables. This is a one-way relationship; a slicer in one table controls a slicer in a second table, but not the reverse.

For example, you can give the organization slicer of table Y control over the organization slicer of table Z. If a user selects Headquarters in the organization slicer of table Y, then Headquarters is automatically selected in the organization slicer of table Z. The organization slicer of table Z does not permit direct selection of organizations; it merely reflects the selections that are made in table Y.

A table can have a mix of controlling slicers and stand-alone slicers or a mix of controlled slicers and stand-alone slicers. However, a table cannot have a mix of controlling slicers and controlled slicers.

To establish a control connection between slicers in different tables:
1. Select any cell in the table that you want to put under the control of another table.
2. Select Table Properties.
3. In the Table Properties window, select the Slicers tab.
4. Use the Shared Slicers section of the Slicers tab to define the connection between tables. For details, see the online Help for the Table Properties window.

Note: This option is available for read-only tables and for data-entry tables in form templates.

Adding Comments to a Cell

About Cell Comments

A cell comment consists of text that you attach to a single cell in a read-only table or a data-entry table. A cell comment is associated with the cell crossing.

Note: If comments are not enabled for a report or a form, you can view existing comments but you cannot add new ones.

Add a Comment

To add a comment to a cell:
1. Select a data cell.
   The cell does not have to be writable, but it must be readable. You cannot add cell comments to supplemental schedules.
2. Click Cell Comments in the Tools group on the SAS Financial Management tab.
3. Click Add Comment.
4. If the comment is only for your own use, select **This comment is private**. Otherwise, the comment might be available in other forms or reports.

*Note:* You cannot go back later and change the comment’s privacy setting. For example, to make a public comment private, you must delete the comment and re-create it. All comments, both public and private, are stored in the SAS Financial Management Data Mart.

**View Comments**

To view cell comments:

1. Select a cell with a red flag in its upper right corner.
   
   Any comments that are associated with that crossing appear in the Cell Comments window. You can leave this window open (or minimized). Its contents change as your cell selections change.

2. To view comments that are associated with subordinate members, select **Show contributing comments indicator**.
   
   In the table, select a cell with a blue flag in its upper left corner. All comments that are associated with any of the crossing’s subordinate members appear in the Cell Comments window.

From the drop-down menu at the right of the comment heading, you can reply to a comment, edit the most recent comment or a reply, sort the replies, or delete comments or replies.

*Note:* If a reply from someone else is attached to a comment, you cannot delete it. Unless you are an administrator, you can delete only comments and replies that you made.

**View the Crossing for a Comment**

To view the crossing for a comment:

1. Click the Slice to contributing crossing button.
   
   The display changes to reflect the crossing that is associated with this comment.

   *Note:* The Frequency and Currency dimensions are not included.

2. To display the previous crossing, click **Return to original view**.
   
   However, be aware that if you have modified the display (for example, by rearranging columns, rows, or slicers), clicking this button might not take you to the original view.

---

**Copying a Read-Only Table to a CDA Table**

To copy the currently displayed slice of a read-only table to a CDA table:
Generating a Forecast

Overview

In a form template, an administrator can generate a forecast that is based on the historical data in the model for the data-entry table. The Forecast wizard uses SAS High-Performance Forecasting to generate the forecast data.

The forecasting software uses sophisticated automatic model selection techniques to choose the best-fitting model for the data. After a successful forecast is complete, this model is stored on the server and can be reused for more efficient forecasting. The forecast parameters are saved with the form template.

If forecasting is enabled for data entry, a user who is editing a form can also generate a forecast. The user’s forecast can reuse the model or request to have a new model generated. However, a forecast model that is generated from a form is not saved.

For details, see the online Help for the Forecast wizard.

Note: Forecasting is available only in financial forms without supplemental schedules.

Execution Time

The time it takes a forecast to execute depends primarily on these factors:

• the number of by-variable members that are selected
• the number of historical and forecast time periods
• whether the forecast model is reused
Because execution time can be lengthy, a forecast runs asynchronously and sends a notification when the forecast completes.

If you have not closed the form or template, a pop-up message appears when the forecast completes. To view the results, refresh the display.

**Forecast Results**

The forecast results are written to the analysis member that was selected for the forecast. If you selected **Use confidence values**, then two additional members, for the upper bound and lower bound of the confidence interval, also hold forecast results.

*Note:* Writing the forecast results, like other data entry operations, causes driver formulas to be executed.

After generating a forecast, you can use the **Create Chart** option to create a Microsoft Excel PivotChart to display the results in Microsoft Excel. See “Creating a Chart from a Table” on page 75. You can also use Excel’s copy and paste functionality to copy forecast results to another part of the table (for example, you might copy the forecast data or the lower bound data to the Budget member).

The object type for forecast-generated data is **forecast** and can be seen if you view contributing data for a crossing.

In SAS Financial Management Studio, the cycle properties contain a history record of the forecast. If the forecast failed, the record contains a link to a detailed report.

---

**Creating a Chart from a Table**

With the **Create Chart** option, you can create an ad hoc Microsoft Excel PivotChart from a SAS Financial Management table. The chart includes the members that are currently displayed in the table.

To create a chart:

1. Click one of the table cells.
2. Select **Edit → Create Chart** from the pop-up menu.
3. Move the chart to an appropriate location in the worksheet.

As you make changes in the table (such as changing a value in a data-entry table or selecting a different slicer member), those changes are reflected in the chart.

For additional customizations, use the **PivotChart Tools** and the **PivotTable Field List** that are available when you click anywhere in the chart. For more information about working with a PivotChart, see the online Help for Microsoft Excel.

*Note:* Charts are not available in Web data entry.

---

**Copying a CDA Table to a Read-Only Table**

To copy a CDA table to a read-only table:
1. Select the exact range of cells that contains the header of the CDA table. These are all the cells above the column headings that contain general information about the table.

2. Select **Copy as Read-only Table**.

   A corresponding read-only table is created in a new worksheet. The upper left cell of the new read-only table is A1. The new read-only table includes all the members of its hierarchies, regardless of any member restrictions in the source CDA table.
Index

A
Adjust Values 30
Adjust Values option 59
alert notifications
  for forms 7
alerts 44
Alerts portlet 7
Allocate option 54
allocation in a top-down workflow 54
approving
  forms 15
attachments
  opening 15
automatic allocation 25

B
bottom-up form status 16
bottom-up workflow 15
  entering data in Excel 54
  reviewing data in Excel 56

C
calculated members 68
capabilities
  for working on forms 8
CDA tables
  copying from read-only tables 73
  copying to read-only tables 75
cell comments 32, 72
cell formats 69
  resolving conflicts 71
cell information 23
cell styles
  modifying 70
  saving in a template 70
charts, creating 75
Check In Form option
Check Out Form option
Collapse option 66
color-coded cells 23, 55
comments
  attached to cell crossings 72
  attached to forms 14
Copy as CDA option 73
Copy as Read-only Table option 75
Copy Cells 26
Create Chart option 75
crossings 20

d
D
data entry
  automatic allocation 25
  parent cells 25
data-entry tables
  calculated members 68
  pop-up menu 65
deadline 10
detail records
  in supplemental schedules 34
dimensions 20
Drill Down option 66
Drill Up option 66

e
editing
  forms 15, 16
editing forms 20
Excel data entry 53
  bottom-up form sets 54
color-coded cells 55
parent cells 56
saving data 55
supplemental schedules 58
top-down form sets 54
virtual children 56
Expand All option 66
Expand option 66
**F**

Filter Member Combination option 66
Filters option 66
financial form sets
  overview 15
Forecast wizard 74
forecasting 74
  results 75
form actions 13
form sets 3
  attachments 15
  financial 3
  operational 3
types 15
form status
  portlet 42
Form Status Dashboard portlet 42
form types 10
Format Cells option 70
Format Members window 70
formats for table cells 69
forms 3
  alert notification 7
  alerts 44
  approving 15
  attachments 15
  bottom-up workflow 15, 54
  checking in
  checking out 8
  comments 14
  data entry 23
  deadline 10
  editing 15, 16, 54
  history 13
  member 10
  minimized 8
  name 10
  opening for Web data entry 8
  opening in Microsoft Excel 8
  overdue 10
  pushing 16
  recalling 15, 16
  rejecting 15
  reviewing 15, 56
  searching the list 11
  sorting the list 11
  status 16, 17
  submitting 15
  submitting parent forms 16
  supplemental schedules 58
top-down workflow 16, 54
type 10
  view available 7
forms, editing
  See Excel data entry
  See offline data entry
  See Web data entry
forms display 10
Forms workspace 3
  attachments 15
  bottom-up form status 16
  columns 10
  data entry 20
  form actions 13
  form comments 14
  grid view 9
  hierarchy view 9
  history 13
  layout 4, 8
  opening 7
  saving search criteria 12
  searching 11
  sending e-mail messages to authors and
  reviewers 13
  sorting the list of forms 11
tasks 7
tile pane 8
top-down form status 17
workflow 13
Frequency dimension 69

**G**
green cells 33, 58

**H**
hierarchies 24

**I**
information maps 42

**L**
linking slicers 71

**N**
New Detail 34
notification type 7

**O**
offline data entry
operational form sets
  overview 15

**P**
parent cells
  entering data 56
Paste Cells 26
Pivot option 66
pivoting tables 66
Preferences
  in portal 7
pushing
  forms 16

R
read-only tables
  calculated members 68
collapsing 66
copying CDA tables to 75
copying to CDA tables 73
expanding 66
filtering 66
pivoting 66
pop-up menu 65
recalling
  forms 16
Refresh All option 55
Refresh option 55
rejecting
  forms 15
reports 44
  opening 37
  searching 38
types 37
viewing 51
Reports workspace 37, 38
  organizing folders 39
reviewing
  forms 15, 56
roll-ups 24

S
SAS Financial Management
  log on 41
  Web preferences 6
SAS High Performance Forecasting 74
SAS Information Delivery Portal
  SAS Financial Management content 42
SAS reports 42
Show Members option 66
slicers 20
  linking between tables 71
selecting 23
spread
  horizontal 26
  vertical 26
spread option 26
Spread option 61
spreading
  over protected cells 30
standard reports 44
stored processes 42, 44
styles for formatting table cells 69
submitting
  forms 15
supplemental schedules
  calculated members 68
detail records 34
entering data 33, 58
saving data 33, 35, 58

T
table cells
  formatting 69
Table Properties option 66
target hierarchy 3
tile pane 8
top-down form status 17
top-down workflow
  entering data in Excel 54
  steps 16

V
virtual children 25, 56

W
Web data entry 20
  adjusting values 30
cell comments 32
cell information 23
copying and pasting cells 26
crossings 20
dimensions 20
drilling down 22
drilling down
  expanding rows and columns 21
form headers 20
headers 20
hierarchies 24
refreshing 24
roll-ups 24
rows and columns 20
Select Member window 23
slicers 20, 23
supplemental schedules 33
virtual children 25
writable cells 23
workflow 13
writable and non–writable cells 23

Y
yellow cells 54